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Practice Manager - Pumasillo Project � Project Summary 
Specification v2.0 
 

1. External References 

Pending acceptance of the Project Summary Specification (PSS) the following documents will be generated 
as dictated by the Unified Document Strategy  (UDS) followed by RealLegal, LLC. 

 

Title Files can be found in… Author Date 

Sign-off and Checklist for Project Summary Specification 
v2.0 

See page C. Tom Foley 03/04/2003 

Functional Requirement Specification for Project 
Summary Specification v2.0 

Not applicable. N/A N/A 

Functional Design Specification for Project Summary 
Specification v2.0 

Not applicable. N/A N/A 

Technical Design Specification for Project Summary 
Specification v2.0 

Not applicable. N/A N/A 

Technical Design Specification for the Project Summary 
Specification v2.0 Data Model. 

Not applicable. N/A N/A 

Test Plans for the Project Summary Specification v2.0 http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/testplans/ 

QA  

Development Schedule for the Project Summary 
Specification v2.0 

Included in the development 
schedule (see 
http://pm.reallegal.com/reallegal/dow
nload/rd/schedules/current_developm
ent_scheduled.html) 

Tom Foley Updated 
Weekly 

Turnover documents http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/turnover/ 

Saulius  

Lead Problem Report for the Project Summary 
Specification v2.0 

http://iowa.pmt.lt/bugs/scripts/BugListi
ng.asp?UPD=0&RESPONSIBLEID=-
1&LOGIN=&APPLICATIONID=45&W
HERE=report.APPLICATIONID%20
%3D%2072%20&ORDER=Status%2
C%20Areas%2C%20Type%2C%20R
eportID 
 
http://thunder/bugs/scripts/BugListing.
asp?UPD=0&RESPONSIBLEID=-
1&LOGIN=&APPLICATIONID=45&W
HERE=report.APPLICATIONID%20
%3D%2072%20&ORDER=Status%2
C%20Areas%2C%20Type%2C%20R
eportID 

QA Updated 
Constantly 

Meeting Minutes for the Project Summary Specification 
v2.0 

http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/other/ 

Tom Foley  
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Title Files can be found in… Author Date 

User Manual for the Project Summary Specification v2.0 http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/doc&help/ 

TechComm  

Install Guide for the Project Summary Specification v2.0 http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/doc&help/ 

Tom Foley  

Project Summary Specification v2.0 Beta Screenshots for 
Marketing 

Not applicable. N/A N/A 

Project Post-Mortem for the Project Summary 
Specification v2.0 

http://pm.reallegal.com/reallegal/dow
nload/pm/pumasillo/kx/other/ 

  

Release Page http://pm.reallegal.com/reallegal/hom
e/pm/pumasillo.htm 

Tom Foley Last Update: 
03/17/2003 

In addition, each of the following integrations has a similar document set that may contain information 
pertinent to this release, as these integrations will be fully supported by Pumasillo: 

1. Authentication Service 

2. DocsOpen Integration – Necessary changes were originally made in PM v8.6, though additional 
requirements could surface during development and testing. 

3. Exchange/Outlook Integration – Some changes were originally made in PM v8.6, but additional changes 
will need to be made in Pumasillo. 

4. Full Text Search – Necessary changes were originally made in PM v8.6, though additional requirements 
could surface during development and testing. 

5. iManage Integration – There are no known changes at this time to support this integration. 

6. Integration Engine FDS – Necessary changes were originally made in PM v8.6, though additional 
requirements could surface during development and testing 

7. Lotus Notes Integration FDS 

8. OCAWatch FDS – Necessary changes were originally made in PM v8.7, though additional requirements 
could surface during development and testing 

9. PCA v3.0 FDS – Necessary changes were originally made in PM v8.7, though additional requirements 
could surface during development and testing 

10. Portal Integration v1.0 FDS 

11. Reporting v1.0 and v2.0 FDSs – No changes have been indicated as being required for this module, 
though changes could surface during development and testing 

12. Schedule Service FDS – Necessary changes were originally made in PM v8.6, though additional 
requirements could surface during development and testing. 
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2. Definition of Terms 

The definition of terms from this document are outlined below. 
 

Term Definition 

FRS / Functional Requirement Specification Generated by Product Management; outlines requirements for the 
product covering one or more releases in order to steer the product in a 
given direction.   

PSS / Project Summary Specification Generated by Program Management to provide a summary of the plan, 
resources, and costs that will be included in each phase of the project. 

FDS / Functional Design Specification A living document generated by Program Management.  It details the 
functionality, interfaces, and use cases of the program for each release 
of the program. 

TDS / Technical Design Specification A living document generated by a Technical Analyst that is carried from 
one release to the next.  Details the technical decisions that are made 
including the technical architecture of the program and its associated 
data model. 

Product A product describes the deliverables of project including the 
executables, installations, documentation, marketing material, support 
plans, and other material. 

Program A program describes the deliverables of one or more projects within the 
development group including code, executables, installations, user 
manuals, install guides, and test plans. 

Project A project consists of a well-defined collection of small jobs (tasks) and 
culminates in a finished product.  A project is temporary in nature 
meaning it has a specific start and finish. 
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3. PSS Introduction 

The Project Summary Specification (PSS) is a document based on the Functional Requirement Specification 
(FRS) and contains the following: 

Ø A summary of the project goals and objectives, major work activities, and major milestones.  

Ø An estimate of the resources and costs involved in seeing the project to its final completion. 

Ø If applicable, a summary of the project's relation to the strategic goals of RealLegal. 

Ø If applicable, the long-term strategic plan set in place for the program including its immediate short-term 
release phases and long-term release schedule. 

Ø A risk management analysis to identify potential risk and mitigate the risk to ensure success of the 
project. 

The accepted (PSS) leads to the development of the Functional Design Specification (FDS) and eventually to 
the Technical Design Specification (TDS). 

 

4. Project Overview 

Pumasillo is an incremental release of Practice Manager, based on a new code base – Chimborazo – that 
includes a new authentication service that will be used for authenticating users and their permissions when 
accessing the product.  This authentication service provides a unified way for all Practice Manager modules 
and integrations, as well, including those that are specifically designed for the Internet. 

The Chimborazo code base, on which Pumasillo was built, was split from the PM87 code (Salado) prior to the 
completion and release of PM87.  This means Pumasillo not only consists of new work, but also consists of 
PCRs that had to be entered in two code bases.  The source of those PCRs are as follows: 

Ø From PM87 (Salado) 
 43 Bugs 
 5 Updates 

Ø From PM87 SP1 (Corazon) 
 143 Bugs 
 5 Features 
 7 Info 
 85 Updates 

Ø From PM87 SP2, SP2A and SP2A EBFs 
 121 Bugs 
 4 Features 
 13 Info 
 53 Updates 

In addition to replicating these PCRs from one code base to another, the following new work is also included: 

1. Changing the Login process to use the RealLegal Practice Manager Authentication Service v1.x. 

2. Inclusion of the Integration Engine v1.x install and upgrade programs in the core Practice Manager install 
and upgrade programs. 
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3. Modification to the Functional Security UI to differentiate between core Practice Manager operations and 
Integration Operations in the Available and Assigned Operations panel of the Assign Functions tab (use 
of a TreeView is the logical course for this). 

4. GMT/UTC Preparation – System Level, requiring the following fields be added (these will be respected 
in future releases of Practice Manager and used by the Exchange and Lotus Notes Integrations, as well as 
the Portal Module): 

a. a. System Settings 

i. Database Server – Time Zone 

ii. Database Server – Automatically Adjust for Daylight Savings Time 

b. b. Sites 

i. Time Zone 

ii. Automatically Adjust for Daylight Savings Time 

5. FormsDesigner rendering code has been removed from the Practice Manager core code, allowing the 
independent development of FormsDesigner.  For Pumasillo, version 3.5 of FormsDesigner will be 
released in parallel, though the files will be installed as part of the Pumasillo install and/or upgrade.  
Going forward, FormsDesigner will have its own install and upgrade programs as new versions become 
available. 

6. Support for the following integrations and modules, when available: 

a. Asbestos Module 

b. Audit Engine 

c. DocsOpen, with the Security 

d. Exchange 2000 and Outlook 2000/XP (Workflow) 

e. Full Text Search 

f. HotDocs 5.3 

g. Integration Engine 

h. Legal Services Module 

i. Lotus Notes (server for workflow and client for groupware) 

j. NTFS Security 

k. OCAWatch 

l. PCA 3.0 

m. Portal 1.0 

n. Reporting 2.0 
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Please note that the designation for the released version of this project has not been determined as of March 
21, 2003.  There are two schools of thought: 

1. Use PM v8.7 SP3 – Because, from a user perspective, the new work represented in this release, for the 
most part, simply represents a minor incremental change in the functionality of the product. 

2. Use PM 8.8 – Because, from a product perspective, the addition of the authentication services, combined 
with the original scope of work AND the new SP3-type PCRs, this is a more substantial release than 
originally planned.  Also, it will be important to be able to differentiate what kind of authentication is 
being used – the authentication available in PM v8.7 and earlier or the new authentication.  Being able to 
reference PM v8.8 versus all other releases will be much easier. 

 

5. Project History (Builds) 

See http://pm.reallegal.com/reallegal/download/pm/pumasillo/kx/turnover/. 
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6. Scope – Inclusions – New Work 

This report is taken from the PCR Database.  It is all PCRs in Pumasillo that, as of March 21, had a status of On Hold, Under Review Pending, 
Done or Final, that are new items added since PM87 SP2.  This list is subject to update, and the PCR Database always represents the latest and 
greatest version of this report. 

The report is first sorted by Area, then Type and then ID. 

There are additional fields available when this report is accessed from the PCR Database.  Note that the links currently point to Thunder.  This 
is only available if you connect to the PCR Database from the Lithuanian office or from the VPN.  At the time this report was generated, there 
as no quick way to correct this.  Future updates should have this corrected. 

 

Area Type ID Description/Comments Site Contact Support 
Tickets 

Auxiliary Settings Feature 14743 Add a new Desktop auxiliary item to support PCR 14741   TF   

Bar Numbers Bug 14259 Date of Admission field on the Bar Number screen should have the same 
mask, as DOB (Or DOD) field on the Other Details of Entity DE 

  Mike G   

Components Bug 14501 Receiving message “Warning, YOUR connection to the database dropped” 
when attempting to set a Default Filter in Matter Settings 

AmFam Mike G Feedback 

Components Bug 14734 Receiving Message "Access violation at address 007ED65E in module 
'PMWIN.exe'. Write of address 000000E0" 

Wilkes 
McHugh 

Mike G Feedback 

Components Info 14808 Columns are being resized continuously (blinking) in Entity listing. Trying to 
save grid layout in this situation causes an error message "Cannot insert 
duplicate 'LSTSET' with unique index 'LSTSET_UNIQUE' " 

  Neringa   

Components Update 4852 Date format is mm/dd/yyyy. Enter 33/22/1111 > System says that 1111/33/22 
is not valid date. Date format is not the same. 

  Arunas   

Database Bug 10916 RLEnterprise integration with PM: There are not deleted assignments in 
RLEnterprise. 

  Vitalius   

Database Bug 10919 RLEnterprise integration with PM: For WebONLY user are created SQL login, 
but user can't login to PMWIN. 

  Vitalius   

Database Bug 12324 Open Administration>System Settings>Error : dbchbEnableDesktopViews: 
field'ENABLEDESKTOPVIEWS' not found 

  Ken   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Database Bug 13253 AUX_ fileds are missing from Entity's Global Listing query. Glasser & 
Glasser - 0185 

Mike G   

Database Info 10358 RealLegal Authentication Service 1.0 Requirement for SP1.   Tom   

Database Info 14176 Paths in different PMWin places are not of the same length.   Donatas   

Database Update 9785 Portal Requirements for SP1 - Data Structure to Allow Timeslips to be Related 
to Multiple Matters. 

  Tom   

Database Update 9786 Portal Requirements for SP1 - Data Structure to Allow Workflow Items to be 
Related to Multiple Matters. 

  Tom   

Database Update 9787 Portal Requirements for SP1 - Data Structure to Allow Groupware Items to be 
Related to Multiple Matters. 

  Tom   

Database Update 9788 Portal Requirements for SP1 - Update Related Tree in Matter to respect 
TIMMATAS, MRULMATAS and RULMATAS. 

  Tom   

Database Update 9972 Script is needed which is to be run when Site Security is enabled and records 
in SITESEC are found, because now it is not possible to enable site security on 
restored database. 

  Donatas   

Database Update 10112 Change LSTDEF.TABLENAME type to varchar(128). Change 
LSTDEF.TABLEALIAS type to varchar(128). 

  Rimas   

Database Update 10356 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Database Update 10357 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Database Update 10365 Functional Security - Assign Functions UI Update - Database changes   Tom   

Database Update 11968 Add timestamp on MATSEC table, when record is being added into this table 
(NTFS integration requirement) 

  Darius K   

Database Update 13966 I had problems using IDGEN through RDS, because RDS default handler is 
able to marshal only single Recordset. I solved the problem by modifying 
IDGEN procedure this way 

  Vitalius   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Desktop Views Feature 14741 Add the ability to include an ActiveX or Web browser form on the desktop 
views 

  TF   

Desktop Views Info 13727 On Next week and Next two weeks time frame under a heading called 
“Current” appear tasks which have the Due Date from current (i.e. although 
time is set to next week, today's, tomorrow's and etc. tasks appear under 
“Current”). 

  Ligita   

Desktop Views Update 10588 Desktop views - Workflow. See comments.   Vaidas   

Document 
Assembly 

Bug 12343 Merge with Word2000. When multiple documents are opened and generate 
one more document (use doc assembly template), then this just generated 
document does not come to the front. I have to click on it on the title bar. 

  Rasa   

Document 
Assembly 

Bug 13228 Access Violations reported by Kelly&Ferraro. See comments for details Kelly & Ferraro Ken; Mike 
G 

22922 

Document 
Assembly 

Bug 13946 In PM, create document profile, create document. Edit it save, then exit. Here 
WP exits but it also shuts PM down instantly. 

Dalan & Katz - 
031.Ticket 
25405 

Ken F; 
Mike G 

25405 

Document 
Assembly 

Bug 14448 Receiving “The server threw an exception” message, when creating a 
document. Also, the same message received when "Entering info in PM8" 

AmFam Mike G, 
Ken F 

Feedback 

Document 
Assembly 

Bug 14495 Receiving message"The server threw an exception" when creating and 
changing documents 

Bacon & 
Wilson 

Mike G Feedback 

Document 
Assembly 

Bug 14751 In WP8, you have your pm document that has an address field pulled in, this 
field is not pulling in for some doc comps. Go to Format, envelope and the 
address field will pull in to the WP envelope but only if it is a basic 

Dalan & Katz Jason 25416 

Document 
Assembly 

Bug 14822 Document Save Error. When creating a Template/Boilerplate combination and 
then trying to save we get an error starting “Subscript out of range.” 

Wards Donatas   

Document 
Assembly 

Bug 14867 Receive Message "DELETE statement conflicted with COLUMN REFERENCE 
constraint 'ASM_UPDATELOG_COMPONENTID_REF'. The conflict occurred 
in database 'PMWinDB', table 'ASM_UPDATELOG', column 'COMPONENTID' 
" 

AmFam Hauf, 
Barb K 

Feedback 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Update 6569 Enable support for Textbridge 2000.   Ricky   

Document 
Assembly 

Update 12259 Replace existing HDExec function call to HotDocs with the Assemble Template 
call 

  Tom   

Document 
Assembly 

Update 14465 Update the document profile so that the "Assemble with..." fields on the Profile 
default to the same component type as that of the default template 

  TF   

Document 
Assembly 

Update 14467 Update the document profile so that the "Assemble with..." fields on the Profile 
default to the same component type as that of the default template 

  TF   

Document 
Assembly Merge 

Bug 13561 When merge document get an error 'Could not find WLL window to 
communicate with Ms Word' 

  Rasa   

Document 
Assembly Merge 

Bug 13643 When merge a document and have got message that letterhead (boilerplate...) 
does not exist, hit on any place in PM (e.g. on Save, Cancel buttons), the 
message hidden behind the PM screen. Maybe should be better, that this 
message should be always on top? 

  Rasa   

Document 
Assembly Merge 

Bug 13808 When the first time click on Generate a document have got 'The conversion of 
a char data type to a datetime data type resulted in an out-of-range datetime 
value'. Click the second time, document is merged. 

  Rasa   

Document 
Assembly Merge 

Bug 14232 Problem when try to copy HotDocs component.   Rasa   

Document 
Assembly Merge 

Bug 14310 When generate some documents with doc assm templates, get access 
violation. 

  Rasa   

Document 
Assembly Merge 

Bug 14312 Word Processor: WP 9.0. Merge document with Doc Assm Template (it has 
some keyboard fields). When Corel application opens the merge process is not 
executing (Merge Message screen displayed, you cannot enter anything, 
cannot Close Corel application) 

  Rasa   

Document 
Assembly 
Settings 

Feature 12711 In Document Assembly Settings, rename "Options" to "General", and move to 
be in the first position. 

 Tom  
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 
Settings 

Bug 13718 Filter 'Assignments to show… All' in Assignment tab has to show Global and 
Author-Specific component assignments, not all assignments of Law category, 
Law Type, etc 

  Abe   

Document 
Assembly 
Settings 

Update 11581 Add a Change Set column to the component listing, to show what the last 
Change Set was that was applied. 

  Tom   

Document DE Bug 10318 Create new Profile Only document, enter required fields and hit Groupware 
button, have got an error 'Invalid variant type conversion'. For the saved Profile 
Only document Groupware button is disabled (also is disabled groupware right 
click menu item) 

  Rasa   

Document DE Bug 11704 Create new Profile Only document > click Groupware button in Profile window 
> get an error: "Invalid variant type conversion". 

      

Document DE Bug 13386 When using Pmpaper.exe a 40 or 50mb file will cause the app to stop running Stephanie J. 
Stevenson, 
P.C. 

Josh 24333 

Document DE Bug 13454 Error 'The server threw an exception.' in Document DE       

Document DE Bug 13455 Error when creating document Bacon & 
Wilson - 0201 

Steve 
Adams 

23422 

Document DE Bug 13795 Problem when create document and select Profile Only template.   Rasa   

Document DE Bug 14111 Fix IDocProfile interface EditDocument implementation so it would not through 
an exception to the callee, if Doc Profile ID is not valid, and would behave 
gracefully as the rest of the DE forms do 

  DK   

Document DE Bug 14442 Error message "External exception C0000006" when clicked on Caption button 
in Document DE 

AmFam Mike G; 
Ken F 

Feedback 

Document DE Bug 14485 Error message "The column prefix 'ENTTYPE' does not match with a table 
name or alias name used in the query" when going to Entities tab in Document 
DE 

AmFam Krebs-
Otto, Rita 
J 

Feedback 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document DE Bug 14538 Receiving Message “One or more items in the folder you synchronized do not 
match. To resolve the conflicts, open the items, and then try this operation 
again” when entering a hearing 

AmFam Mike G Feedback 

Document DE Bug 14649 Receiving Message "Warning, YOUR connection to the database dropped" 
when Trying to generate a document 

AmFam Mike G Feedback 

Document DE Bug 14681 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Document DE Bug 14727 Regional Options are not respected in following places.   Neringa   

Document DE Bug 14832 Timeout expired error when savin Document Profile AmFam Ginder, 
Carolyn S 

Feedback 

Document DE Bug 14869 Access violation at address 0066EA44 in module 'PMWIN.exe'. Read of 
address 00000008 

AmFam Corrigan, 
William J 

Feedback 

Document DE Update 14061 IDocProfile.EditDocument OLE method: if invoked with non-existing doc profile 
ID, fails to close form correctly and throws exception to the callee. Must be 
fixed 

  DK   

Document Listing Bug 14386 If you remove Primary Matter No column from the listing and save Grid layout, 
after closing and reopening PM column still displayed. 

Summer S Mike G   

Document Listing Bug 14679 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Document 
Settings 

Feature 12710 In Document Settings, rename "Options" to "General", and move to be in the 
first position. Move all document-specific system settings to that tab. 

 Tom  

Document 
Settings 

Bug 13688 Tab order is incorrect in Document Template DE   DK   

Document 
Settings 

Bug 14736 Receive Message "Warning, YOUR connection to the database dropped" when 
in document settings trying to set up a new form 

AmFam Mike G Feedback 

Document 
Template 

Bug 12221 If in the PM80 document template was checked 'Skip Document Assembly', 
after upgrade, the radio buttons of document assignments are enable. 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Documentation/M
anuals/Help 

Bug 14789 There was an error on the start.htm page in the utilities\ subfolder for 
PMTemplate.exe 

  TF   

Documentation/M
anuals/Help 

Bug 14799 Correct the restore instructions for MSWDAFIX.EXE   Tom   

Documentation/M
anuals/Help 

Update 9842 Update TO with the following "OCX files are registered by installs/upgrades. If 
user does not use installs/upgrades, they have to register those components 
by hand". 

  Ken; 
Daiva 

  

Documentation/M
anuals/Help 

Update 10417 Update Beta and GA Network Install and Upgrade Splash Screen, Readme 
Files, Start pages and License files for SP1. 

  Tom   

Documentation/M
anuals/Help 

Update 10418 Update Beta and GA Client Install and Upgrade Splash Screen, Readme Files, 
Start pages and License files for SP1. 

  Tom   

Documentation/M
anuals/Help 

Update 10419 Update Beta and GA PMRemote Install and Upgrade Splash Screen, Readme 
Files, Start pages and License files for SP1. 

  Tom   

Documentation/M
anuals/Help 

Update 14481 Update readme.txt with info regarding <PMROOT>\KOFAX_INS directory - see 
14410 

  Donatas   

Documentation/M
anuals/Help 

Update 14482 Update TO with info regarding <PMROOT>\KOFAX_INS directory - see 14410   Donatas   

Documentation/M
anuals/Help 

Update 14582 Create install and upgrade files for Pumasillo, as well as update the release 
notes 

  TF   

Entity Assign Bug 12101 Role Details filed accepts more than database allows (Matter->Entiry Assign 
Wizard->Additional Information tab). I can enter as many characters as I want, 
but RoleDetails field has 150 ch limit (Assign table). 

  Mike G   

Entity Assign Update 4730 Matter DE: Qverview: Billings: Report/Bill to tab. Press new > Assign Wizard 
window appears. There is only "New" button in this window. There should also 
be "Select" and "Close" buttons. 

  Arunas   

Entity DE Bug 10954 Do not allow enter lines, containing only spaces, into address (like now empty 
line in address is discarded) 

  Donatas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity DE Bug 11950 creating new organization entity cannot get focus on a field after the message, 
that such company already exists 

  Sigita   

Entity DE Bug 12224 Site Security is on. Open entity which has selected Parent Organization and is 
from another site. Go to General:Addresses tab, check/uncheck 'View Parent 
Organization Addresses', hit Close. Entity is not Closed. It is closed just from 
Other Details tab. 

  Rasa   

Entity DE Bug 13313 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Entity DE Bug 13666 When open Issue DE from Entity Related Tree, "Specific to this matter" 
checkbox should be disabled or invisible 

  Donatas   

Entity DE Bug 14300 Access Violation when checking on an entity for a phone number. Bacon&Wilson Alice D. 
Delorme 

Feedback 

Entity DE Bug 14328 Error "Invalid column name 'MEDCAREPRID'" when cancelling the "adding" of 
an entity (adding a party) 

  McRae 
Huszagh 

Feedback 

Entity DE Bug 14450 Receiving “Warning, YOUR connection to the database dropped” Message 
,when GOING FROM GENERAL TAB TO OTHER DETAILS IN AN ENTITY. 

AmFam Mike G, 
Ken F 

Feedback 

Entity DE Bug 14503 Receiving message “A component named frmEntityInfo already exists” when 
trying to look at an address of an already assigned entity 

AmFam Mike G Feedback 

Entity DE Bug 14523 Access violation when going from the assign screen to the detail screen - 
where we put in the date of birth and SS# 

AmFam Swenson, 
Angela J 

Feedback 

Entity DE Bug 14530 Access Violation when attempting to open an entity to make modifications AmFam Conover, 
Sarah J 

Feedback 

Entity DE Bug 14536 Received "Access violation at address 007F8AE3 in module 'pmwin.exe'. Read 
of address 00000008" error when switching from general to other details tab in 
entities 

Wilkes & 
McHugh 

Mike G Feedback 

Entity DE Bug 14540 Receiving "Access violation at address 007ED65E in module 'PMWIN.exe'. 
Write of address 000000E0" when Opening Address on Entity 

AmFam Mike G Feedback 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity DE Bug 14550 Receiving Message “A component named frmEntityInfo already exists” when in 
entities 

Wilkes & 
McHugh 

Mike G Feedback 

Entity DE Bug 14604 Receive "Access violation at address 007ED65E in module 'PMWIN.exe" error. AmFam Mike G Feedback 

Entity DE Bug 14675 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Entity DE Feature 11343 Add "Address" label below Description (Entity entry, Primary Address tab).   Mike G   

Entity DE Update 10352 RealLegal Authentication Service 1.0 Requirment for SP1   Tom   

Entity DE Update 11010 View menu changes   Donatas   

Entity DE Update 11238 "Side" drop-down list should be named "Firm Side" (Entity screen, General tab)   Mike G   

Entity DE Update 11413 PCA 3.1 Requirements for Chimborazo: Entities - New option group Select 
Timeslip Rates Based on 

  Donatas   

Entity DE Update 12891 Whenever you change the Prefix or the Last Name, repopulate the Salutation 
field, even if it is not null 

  Tom   

Entity DE Update 13226 Do we need the same functionality for Billable as we have with client with 
respect to "Client Requires Number"? 

AmFam Tom 26357 

Entity Listing Bug 10394 Create new User with different Home and Default Sites, go to Entity listing (any 
of them) - user's Security Level column is empty. If edit user and change it's 
sites to same, Security Level is shown in listing. 

  Donatas   

Entity Listing Bug 10790 Error message when deleting entity.   Vaidas   

Entity Listing Bug 10955 If entity has got all three lines in it's address, and City, in entity Preview 
Address field focus is set on last line - thus first line is not visible in preview. 

  Donatas   

Entity Listing Bug 11665 Some of Entity Auxiliaries does not fit into Entity listing Preview panel   Donatas   

Entity Listing Bug 12598 Clicking Clear filter and query should clear filter and display all entity types.   Mike G   

Entity Listing Bug 14602 Receive Message "Warning, YOUR connection to the database dropped" when 
going to Edit Preferences from Related Tree of Entity 

AmFam Mike G Feedback 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity Listing Bug 14673 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Entity Listing Bug 14819 Multiple recods in listing when filtering by Issue   Vitalius   

Entity Listing Update 11287 Entity Record Comments Screen should be renamed to "Comments" to be 
consistent with the preview pane view AND to avoid confusion with Notes 
button. 

Lewis Kinard Lewis; 
Mike G 

  

Entity Listing Update 11321 Update Entity Listing Quick Filter to be consistent with other Quick Filters.   Tom   

Entity Listing Update 12770 Publish the auto-refresh method for the Global Entity listing   Tom   

Entity Listing Update 14384 Ability to "Save Grid Layout" in "Related Matters" dialog box (this one is really 
important, particularly if used as part of conflicts checking) 

Shriners Mike G   

Entity Merge Bug 11679 Problems after Entity Merge. Create an entity 1, fill all the required fields. 
Create entity 2, fill all the required fields. Create entity 3, fill all the required 
fields. 

  Arunas   

Entity Merge Bug 14713 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Entity Settings Bug 14446 Receive “Warning, YOUR connection to the database dropped” message, 
when working in the Entities settings. 

AmFam Mike G; 
Ken F 

Feedback 

Entity Settings Bug 14677 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Entity Settings Feature 12709 In Entity Settings, add new "General" tab in the first position and move all 
entity-specific system settings to that tab 

  Tom   

Entity Settings Update 11239 Remove tabs highligting (When hovered over, Entity settings screen)   Mike G   

Entity Settings Update 12918 Tabs within Entity Settings should be in this order (related to 12709 - rename 
as needed): 

  Tom   

Entity: Tree View Bug 14657 Error message displays on sending a mail from Groupware.   Neringa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Filter Bug 13754 Remove mask from Entity Filter All Phone#s field. Add support of wildcards   Mike G   

Filter Bug 13916 Groupware global listing filter: Sent Date To, Start Date To, Due Date To, 
Event Date To-Date From fields do not work properly 

  Mike G   

Filter Update 11329 Update "ALL" functionality on listing.   Vaidas   

General Update 14204 Remove the Files\ subfolder from the turnover file set. The only folders that 
should be included are the Install, Upgrade and KX folders 

  TF   

Groupware DE Bug 14454 Receiving “Warning, YOUR connection to the database dropped” message, 
when in creating a new task in Groupware. 

AmFam Mike G, 
Ken F 

Feedback 

Groupware DE Bug 14544 Receiving Message “One or more items in the folder you synchronized do not 
match. To resolve the conflicts, open the items, and then try this operation 
again” when SENDING APPT IN PM GROUPWARE TO OUTLOOK SENDS 
APPT TO OUTLOOK NOT SAVED IN GROUPWARE 

AmFam Mike G Feedback 

Groupware DE Bug 14546 Receiving Message “Description>Cannot resolve recipient – To” when sending 
an appintment through Groupware 

Fuller, Johnson 
& Farrell 

Mike G Feedback 

Groupware DE Bug 14606 Receive "Warning, YOUR connection to the database dropped" when Trying to 
send a note by e-mail 

AmFam Mike G Feedback 

Groupware DE Bug 14645 Error message "Exception occurred: External exception C0000006" when drag 
incoming mail into a matter 

AmFam Long, 
Gwendoly
n K 

Feedback 

Groupware DE Bug 14800 An unknown error occurred Glasser Richard 
Serpe 

Feedback;26
418 

Groupware DE Bug 14803 Cannot get message ID from Microsoft Outlook AmFam Zacharczy
k, Arthur 
G 

Feedback 

Groupware DE Update 13964 Sending Groupware from Note DE does not supports System Setting "Use 
ClientNumber.MatterNumber" in Subject 

  Donatas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Groupware 
Listing 

Bug 11367 Bad message when deleting Groupware item.   Vaidas   

Groupware 
Listing 

Bug 14573 Receive Message "Warning, YOUR connection to the database dropped" when 
Checking email coming in - recorded statement from WDM word processing 

AmFam Mike G Feedback 

Groupware 
Listing 

Bug 14697 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Groupware 
Settings 

Feature 12713  In Groupware Settings, rename "Options" to "General", and move to be in the 
first position. 

 Tom  

Groupware 
Settings 

Bug 14699 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Guideline Update 10012 OCA Watch requirement for PMWin:   Darius K   

Guideline Update 10017 PCA 3.0 requirement for PMWIN:   Darius K   

Guideline Update 10353 RealLegal Authentication Service 1.0 Requirment for SP1   Tom   

Guideline Update 10875 Practice Manager > Administration > System Settings > Adapters > Configure. 
When attempting to open FTS from configure button in PM, user gets "Cannot 
configure from the workstation" error. 

  Aurelija; 
Gedas 

  

Guideline Update 13126 Update product copyright information to 'RealLegal, LLC. 1992-2003. All rights 
reserved' 

  Tom   

Guideline Info 14010 WindowsXP with SP1. When opening a file from another computer ( 
PMWin.exe for example) User will be presented with a warning screen. 

      

Help Update 14617 Remove the links to the User's Guide and Administrator's Guide from the Help 
menu and Start menu. Also remove pm.ag.pdf and pm.ug.pdf from the file set 

  TF   

Help Update 14764 Update feedback module   TF   

Imageview Bug 10658 Problem with Image- and Tiff- viewers. See comments   Vaidas   

Imageview Bug 13545 Out of memory error using TextBridge OCR: Amfam Ken   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Imageview Bug 13829 In Window menu displayed not all of document's pages and order of pages is 
incorrect. 

  Rasa   

Imageview Bug 14102 I just noticed that there is still logo and company name of law.com on the left 
side of %subj%. PM version is 8.7 SP2A. 

  Audrius   

Imageview Bug 14516 When close ImageViewer window, have got an error.   Rasa   

Imageview Update 10444 Update/recompile Image Viewer to support data structure changes in SP1. 
This should be implemented at end of Beta. 

  Daiva   

Imageview Update 10445 Update/recompile Tiff Viewer to support data structure changes in SP1. This 
should be implemented at end of Beta. 

  Daiva   

Install/ Upgrade Bug 10757 When installing PM Server, there are grammar errors in Authentication 
information required for external WEB users window. 

  Arunas   

Install/ Upgrade Bug 10772 When uprgading pm server, go until "Enter the MS SQL Server administrator 
name and password for RLEnterprise database" window, click Back > you are 
in the next window instead of previous one. 

  Arunas   

Install/ Upgrade Bug 10831 When installing PM Client, I see the installs copying something into 
MDAC26tmp folder. But current PM should be related only with MDAC 2.7 

  Arunas   

Install/ Upgrade Bug 10914 Run PM Upgrade program > choose Repair. The repair option does not 
upgrade (if necessary) database. 

  Arunas   

Install/ Upgrade Bug 10944 Errors during install - see comments PMWin database was on server 
DONATAS, RLENTERPRISE was on LTDEVSQL2 

  Donatas   

Install/ Upgrade Bug 10964 When Workstation upgrade can not find workstation installed, it displays 
message with spelling error. 

  Donatas   

Install/ Upgrade Bug 13975 When I select to install HotDocs, in Doc settings>Application Hot docs should 
assemble witth the default WP I selected during install. 

  Ken   

Install/ Upgrade Bug 14081 This happens right after install (being run on the file server MPPMFS01) asks 
for login to the SQL Server. I have selected MPSQL02, SA, blank password 

  Gedas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Install/ Upgrade Bug 14085 Running client install on the Citrix server MPCTX-01 crashed the OS   Gedas   

Install/ Upgrade Bug 14185 Install PM 8.6.35, upgrade it to 8.7.40 and run uninstall > initial Uninstall 
window talks about PM 8.6 (for both - client and network server). 

  Arunas   

Install/ Upgrade Bug 14209 In PM 8.0.75.1 select International Format checkbox in System Settings. 
Upgrade PM to 8.7.40.1 - International Format checkbox is no longer selected. 

  Arunas   

Install/ Upgrade Bug 14361 When installing, make path be F:pmwin\pm87 ('\' is missing after F:), where F: 
is my system disk > installation accepts this path and puts all the files to 
F:\WinNT\System32\pmwin\pm87. 

  Arunas   

Install/ Upgrade Bug 14866 Spelling Error in error message on installing pmwin 8.7SP2a client.   Mike G   

Install/ Upgrade Info 12805 Upgrading to this release of Practice Manager requires the existing installation 
of Practice Manager already be successfully upgraded to Practice Manager 
8.7, as that is the only upgrade path we will be supporting going forward 

  Tom   

Install/ Upgrade Info 14044 This release of Practice Manager only supports upgrades from v87 or higher   TF   

Install/ Upgrade Update 10359 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Install/ Upgrade Update 10360 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Install/ Upgrade Update 10362 Integration Engine Install/Upgrade Requirements for SP1 - Network 
Installation. 

  Tom   

Install/ Upgrade Update 10363 Integration Engine Install/Upgrade Requirements for SP1 - Client Installation.   Tom   

Install/ Upgrade Update 10380 Reporting Requirements for PM 8.7 SP1   Tom   

Install/ Upgrade Update 10408 The RealLegal.CAAPICORE.dll must be installed into $Program Files\Common 
Files\RealLegal and registered on the Workstation Install. 

  Lee   

Install/ Upgrade Update 10409 The $System32\RealLegal.DataService.Udl must be created by the 
Workstation installation; it specifies the location of the RLENTERPRISE 
database. 

  Lee   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Install/ Upgrade Update 10634 When ESD components are installed (during PM server installation), an empty 
row appears in add/remove programs panel. This happens on Windows NT 
and 98 (98 SE). 

  Arunas   

Install/ Upgrade Update 10642 Install PM 8.5 network server. Go to Control Panel > Add/Remove programs > 
there is a record about it: Practice Manager 8.1. OK. Run upgrade to upgrade 
PM to the latest version. 

  Arunas   

Install/ Upgrade Update 10682 If I delete PMWIN.exe file and then run network server upgrade > choose 
Repair option > upgrade program does not add new PMWIN.exe file into 
<PMROOT> directory. I suppose Repair should do it. 

  Arunas   

Install/ Upgrade Update 14583 Update the installs and upgrade programs with files from PCR 14582   TF   

Install/ Upgrade Update 14584 Update the install programs for GA release with the PUMASILLO program file 
set (see 14582) 

  TF   

Install/ Upgrade Update 14585 Update the upgrade programs for GA release with the PUMASILLO program 
file set 

  TF   

Install/ Upgrade Update 14619 Remove pm.ag.pdf and pm.ug.pdf from the file set. If found on upgrade, 
remove them from the Help menu 

  TF   

Issue Settings Bug 14707 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Legal Vision 
Integration 

Bug 8348 Edit button is not disabled in matter Rates field.   Dalia   

Legal Vision 
Integration 

Bug 9508 When clicking “Yes” without a Transaction Code, you receive the message 
“Transaction posted successfully to Legal Vision”. There is no option to not use 
transaction codes in Timeslip settings, just sub transaction codes. 

0208; Carole 
Redoble 

0208-2379 

Legal Vision 
Integration 

Bug 9799 Timekeeper is not posted to Legal Vision.   Dalia   

Legal Vision 
Integration 

Bug 9800 Need a new message, if timekeeper is not posted to legal vision.   Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Legal Vision 
Integration 

Bug 11130 Matter Synchronization from Legal Vision To PM is not working   Dalia   

Legal Vision 
Integration 

Bug 11220 Changes to lawyer entities does not pass for existing matter   Dalia   

Legal Vision 
Integration 

Bug 11221 Change the lawyer in the matter and do not do any changes in General tab> 
this matter DE. Hit on button 'Save' in this Matter DE >General tab.. Message 
about matter posting to LV does not appear. 

  Dalia   

Legal Vision 
Integration 

Bug 11276 Try to open archived timeslip listing, have got an error:'General SQL error. The 
column prefix 'TIMESPIL' does not match with a table name or alias name 
used in the query.' 

  Dalia   

Legal Vision 
Integration 

Bug 11277 Create a new matter. Matter is succesfully posted to Legal Vision. In 
Information screen hit on button 'Matter rates'.There are no items in Matter 
rates screen, but button 'Edit' is not disabled. 

  Dalia   

Legal Vision 
Integration 

Bug 11278 IF Is not checked on any checkbox in Synchronization screen> General 
tab>Timeslip Listing, Synchronize button must be disabled. 

  Dalia   

Legal Vision 
Integration 

Bug 11279 When clicking “Yes” without a Transaction Code, you receive the message 
“Transaction posted successfully to Legal Vision”. There are no options, to not 
use transaction codes in Timeslip settings, just sub transaction codes. 

  Dalia   

Legal Vision 
Integration 

Bug 11280 In Timeslip listing>Profile tab hit on 'A/R Inquiry' button. Maximize A/R Inquiry 
screen- screen is maximized not correctly 

  Dalia   

Legal Vision 
Integration 

Bug 11283 Entering bad user name or password into Login to LV screen.   Dalia   

Legal Vision 
Integration 

Bug 11284 Entering bad user name or password into Login to LV screen.   Dalia   

Legal Vision 
Integration 

Bug 11286 If user will edit timekeeper match field after creating a new timekeeper, this 
change will be not posted to LV. If user will try to edit that match field we must 
add a message that after edditing this change will be not to LV. 

  Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Legal Vision 
Integration 

Bug 11290 Entering bad user name or password into Login to LV screen.   Dalia   

Legal Vision 
Integration 

Bug 12587 LV rates where not populated in timeslip DE.   Dalia   

Legal Vision 
Integration 

Bug 12626 Use new pmwindb. Open synchronization screen. Check on all checkboxes 
and try to synchronize. Have got an error: string or binary data would be 
truncated. Not all timekeepers are synchronized from LV to PM. 

  Dalia   

Legal Vision 
Integration 

Bug 12762 Activity codes tab is empty. Synchronize activities from LV to PM. Appears not 
all activities in PM. Do not changes and synchronize another time- now all 
activity codes synchronized from LV to PM. 

  Dalia   

Legal Vision 
Integration 

Bug 12791 Load PMWIN. Open Timeslip listing. Login to LV. Assign all timeslip listings 
columns. Now filter timeslip listing by timekeeper and matter (to see LV 
timeslips). Apply filter. Have got ADO error: 

  Dalia   

Legal Vision 
Integration 

Bug 12798 During synchronization process button 'Synchronize' must be disabled. ( In 
Timeslip settings>general tab) 

  Dalia   

Legal Vision 
Integration 

Bug 12800 There is no possibility to search by any column in matter rates screen.   Dalia   

Legal Vision 
Integration 

Bug 13223 Change date/Time format in System settings : use date separator -. Now go to 
matter rates tab>Change rate> item disappears from Matter rates listing. Must 
reopen matter rates screen, if want to see matter rates item. 

  Dalia   

Legal Vision 
Integration 

Update 8217 In User Preferences>General tab >Matter Information Screen Active tab check 
on Timeslip checkbox. In Timeslip Settings>general tab select billing program 
'Legal Vision'. Try to open standart or speciffic matter- have got an error ' 
Invalid class string'. 

  Dalia   

Legal Vision 
Integration 

Update 8346 In Timeslip settings >General tab select Billing Program Legal vision and select 
timeslip Export directory. Open timeslip listing. Using right click hit on 
'Export'.Nothing happens. 

  Dalia   

Legal Vision 
Integration 

Update 11531 Review the codes, and come up with a way to match existing codes in PM to 
codes in LegalVision (see comments) 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Legal Vision 
Integration 

Update 12761 Update message 'Cannot Post Timekeeper to Legal Vision. Reason: 
Timekeeper record does not exist. Do you want to create new timekeeper in 
Legal Vision'. 

  Dalia   

Litigation Specific 
Settings 

Bug 14721 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Login Bug 3281 I have added support for two new parameters "/srv=" and "/db=" as well as two 
new functions ParamExists and GetParam. /srv and /db alows you to overwrite 
default server and database name specified in the alias. 

  David Cox   

Login Bug 10619 Changing active site when record is editited. See Comments   Vaidas   

Login Update 10354 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Login Update 11469 Implement changes discussed during the Authentication Meeting. Implement 
full login authentication using the authentication API; requires SOAP to be 
installed and for the WSDL to be populated in the registry. 

  TF   

Login Update 11470 Implement changes discussed during the Authentication Meeting. Remove 
RLENT synchronization from the functional security dialogs. Only synchronize 
the creation, edit, and deletion of users. 

  TF   

Login Update 14078 Take login code from PMWin and make it to be a separate object   DK   

Login Update 14079 Update security COM object to retrieve functional securities using a ticket   Vitalius   

Mail Merge Bug 14715 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Matter DE Bug 8722 Citrix enviroment (login like a simple user) - Intake_default.ocx and 
Matter_default.ocx. I create a law type with intake_default.ocx and 
matter_default.ocx. After using Intake Wizard I try to create matter with this law 
type, have got 

  Rasa   

Matter DE Bug 10534 Error message "The column prefix 'LWAS' does not match with a table name or 
alias name used in the query." 

  Vaidas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter DE Bug 11139 When you attempt to create a Timkeeper-Matter Rate within a Matter, the 
Matter is not pre-selected. Therefore you must select the matter each time you 
create a rate. 

  Mike G   

Matter DE Bug 11226 Change Error message "You must enter a Matter Name before you continue" 
to "You must enter a Search Name before you continue" (when creating new 
Matter and not entering Search name) 

  Mike G   

Matter DE Bug 11429 Tab order is not correct in PCA intake wizard screen and in pca matter screen.   Dalia   

Matter DE Bug 11433 If focus is left on Parent Matter field in Matter DE form have an error 
:'Underfined parent matter'. 

  Dalia   

Matter DE Bug 11803 Matter -> Annotations tab -> clicking on Filter button brings up "Annotation 
Filter" screen, which looks like Query screen. Clicking on Query button brings 
up the same screen 

  Mike G   

Matter DE Bug 14548 Receiving Message “Warning, YOUR connection to the database dropped” 
when Trying to assign entity in matter 

AmFam Mike G Feedback 

Matter DE Bug 14571 Receive Message “A component named frmEntityInfo already exists”when 
Entering Entity information in the Matter. Also, when Updating Entity address 
information. 

AmFam Mike G Feedbak 

Matter DE Bug 14663 Regional Options are not respected in following places.   Neringa   

Matter DE Bug 14669 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Matter DE Bug 14874 Warning, YOUR connection to the database dropped AmFam Vandevoo
rde, Lisa 
A 

Feedback 

Matter DE Update 11806 Matter DE -> Issues tab -> Created At column should be renamed to Date 
Created. Same on the Available Issues Screen 

  Mike G   

Matter Listing Bug 10538 Error message "Access violation at address 779D92CB in module 
'oleout32.dll'. Read of address 87BD9D49." 

  Vaidas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter Listing Bug 10828 Problem with query. See comments.   Vaidas   

Matter Listing Bug 11578 Problem with query. See Comments   Vaidas   

Matter Listing Bug 14499 Trying to retrieve a filter which worked fine when it was created and applied, 
but every time we try to use the filter after that it gives the error below. We’ve 
tried clearing all filters before applying it and it still doesn’t work. 

Glasser and 
Glasser 

Mike G Feedback 

Matter Listing Bug 14528 Not all matter-related items, mentioned in the message, appering after 
choosing some matter for deletion, are deleted. 

  Sigita   

Matter Listing Bug 14542 Receiving Message “Warning, YOUR connection to the database dropped” 
when Going into preferences from Matter listings 

AmFam Mike G Feedback 

Matter Listing Bug 14575 Receive Message "Warning, YOUR connection to the database dropped" when 
Looking up claims numbers under "matter name" 

AmFam Mike G Feedback 

Matter Listing Bug 14667 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Matter Listing Update 11233 Add checkbox called "Other" next to "Open" and "Closed" (Matter Listing)   Mike G   

Matter Settings Bug 14671 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Matter Settings Update 10372 PCA 3.0 Requirement for SP1 - Implementing PCA Matter screen as a 
standard Matter in Practice Manager. 

  Tom   

Matter Settings Feature 12708 In Matter Settings, add new "General" tab in the first position and move all 
matter-specific system settings to that tab. 

 Tom  

Matter:Annotation
s 

Update 14560 Add auto-refresh to the Matter-Annotation listing to respect the System Setting   TF   

Matter:Auxiliary Update 11945 scoll bars are needed to auxiliary screen   Sigita   

Matter:Defendant Bug 14725 Regional Options are not respected in following places.   Neringa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter:Document
s 

Bug 14497 Receiving message "Exception occurred" every time I create a new document, 
in all matters 

Bacon & 
Wilson 

Mike G Feedback 

Matter:Document
s 

Bug 14873 Timeout expired AmFam Kessler, 
Brian R 

Feedback 

Matter:Entities Update 11588 In System settings check 'Disable Entity Assignment Wizard'. When assign all 
available entities to the matter and this matter already has the entity assigned 
with selected role, no message is displayed. 

  Rasa   

Matter:Entities Update 11622 Relationship Properties screen - Define relationship field allows only two lines 
of text. It should allow more 

  Mike G   

Matter:Entities Update 11911 New/Updated Securities for Matter-Entity Assignments   Tom   

Matter:Overview Bug 14685 Regional Options are not respected in following places.   Neringa   

Matter:Plaintiff Bug 14688 Regional Options are not respected in following places.   Neringa   

Matter:Timeslip Bug 11888 You could login to Juris, when enter incorrect UserID or incorrect Password.   Rasa   

Matter:Timeslip Bug 14665 Regional Options are not respected in following places.   Neringa   

Matter:Tree View Update 13776 Cannot view type from within timeslips when selected as a viewable column. NFI Industries 
0262 

Ken 25144 

Matter:Workflow Feature 14871 When user opens workflow item, which belongs to some plan, open that plan in 
separate window without opening Matter DE, like in 8.0 

  Tom   

Matter:Workflow Update 10295 Workflow plans display all the branches after upgrade from 8.0 to 8.7.24 - not 
only for selected Answers 

  Richard; 
Donatas 

  

Menu Engine Update 10271 Menu Engine update.   Darius K   

Note DE Bug 11669 Spell check notes on save setting is not working correctly   Dalia   

Note DE Bug 11672 User cannot get message 'The Note is not assigned to any matters. Are you 
sure you want to save this note?' if is viewing note without assigned matter or 
close note from ex. Entities tab. 

  Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Note DE Bug 11681 Open Note DE>Related annotation tab. Search it by any column. Select 
another annotation using index lookup- search screen is still active. The same 
is in annotation listing 

  Dalia   

Note DE Bug 11684 Open Note listing> Phone call DE>Details tab> Entity listing. Create a new 
phone call. Hit on 'Timeslips' in Phone DE>Details tab. Phone call de is closing 
and timeslips is opening under entity listing and another phone call screens. 

  Dalia   

Note DE Bug 11686 Open Phone call de> Relate to matters, Relate to entities or Relate to issues 
tab. Search by any column in Available items and Assigned items screens. Go 
to other tab. Search screen is still active. 

  Dalia   

Note DE Bug 13806 In Note DE have got an error 'Cannot focus a disabled or invisible window 
Select TexT'. 

  Rasa   

Note DE Bug 14579 Receiving Message "Warning, YOUR connection to the database dropped" 
when Attempting to enter new Note 

AmFam Mike G Feedback 

Note DE Bug 14693 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Note Listing Bug 14691 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Note Listing Update 11636 Note listing-filter title bar should display Note Filter, not Notebook filter   Mike G   

Note Listing Update 11637 Note listing-Filter screen has checkbox called Preview; it should be called 
Preview Item, as right -click menu option 

  Mike G   

Note Listing Update 11890 Add multi-select to the Note listing and update listing functionality to support it   Tom   

Note Listing Update 12229 If user does not have permission to create phone calls, hide the New Phone 
Call button 

  Tom   

Note Listing Update 12772 Publish the auto-refresh method for the Global Note listing   Tom   

Note Listing Update 14002 Add Other Party, Other Party’s Phone Number and Message text as available 
columns in the Notes Global listing 

Wilkes & 
McHugh 

Cynthia K; 
Mike G 

24503 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Note Settings Bug 14444 Receive “Warning, YOUR connection to the database dropped” message, 
when clicking on the administration menu – Notes 

AmFam Mike G, 
Ken F 

Feedback 

Note Settings Bug 14695 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Note Settings Feature 12715 In Note Settings, add new "General" tab in the first position and move the 
Phone Call Settings field to that tab 

  Tom   

Note Settings Update 12923 Tabs in Note Settings should be in this order (related to 12715 - rename as 
needed): 

  Tom   

Phone Call DE Bug 12240 Open existing Phone Call, do not change anything, press Close - message 
'Save Changes?' is displayed. 

  Tom   

Phone Call 
Settings 

Bug 14709 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Printing Bug 12813 Entity Listing, select Print to Printer, in Report Settings screen Customize tab 
assign all available Field. Hit Preview. Nothing. Reports Preview screen is not 
opened. 

  Rasa   

Printing Bug 14318 Clicking Cancel on the Print dialog box doesn't cancel printing.   Mike G   

Printing Update 14469 Update the Save As functionality for list printing to by-pass QuickReports 
limitation on only saving what is in the preview -- all selected columns should 
be saved to the file 

  TF   

Publish Points Bug 10895 OCA Watch must be installed. Go to Matter Workflow listing, right click mouse 
> select OCA Watch - Firm Docket Calendar > OCA Watch web page opens 
(this is OK) and new separate Workflow listing window appears (This is a bug). 

  Edmunda
s; Arunas 

  

Publish Points Update 9790 Portal Requirements for SP1 - Remove Publish from the right-click menus 
added in 6990, 6992, 6995, 7000, 7003, 7006, and 7009. This will now be 
handled by the Portal Integration. 

  Tom   

Publish Points Update 9791 Portal Requirements for SP1 - Remove the Publish button from the toolbar 
added in 7013. This will now be handled by the Portal Integration when that 
functionality. 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Publish Points Update 10553 Implement a Publish Point for the Workflow Plan tab popup menu.   Rimas; 
Edmunda
s 

  

Publish Points Update 11346 Publish Points update.   Darius K   

Remote Update 10827 Update Remote to match database changes.   Arunas   

Security Settings Bug 10392 Error in message, when changing Site security from None to Exclusionary 
(previous is Inclusionary) 

  Donatas   

Security Settings Bug 10901 Error message "Error occurred synchronyzing entity to RealLegal 
Authentication Service. Error: Cannot insert the value NULL into column 
'SOURCE_ID', table 'RLENTERPRISE_demo.dbo.DATASVC_ASSIGNMENT'; 
column does not allow nulls. INSERT fails. 

  Vaidas   

Security Settings Update 10366 Functional Security - Assign Functions UI Update - Changes in "Functional 
Security -> Assign Functions" screen. 

  Tom   

Security Settings Update 10367 Functional Security - Assign Functions UI Update - Functionality in "Functional 
Security -> Assign Functions" screen. 

  Tom   

Security Settings Update 10771 Functional Security - Assign Functions tab. There is no possibility to filter 
security by Description any more - it is very unconvenient. 

  Daiva   

Security Settings Update 10845 Functional security > Assign functions. See comments   Vaidas   

Security Settings Update 11912 Add respecting of Site Security to entity-specific and matter-specific entity 
relationships 

  Tom   

Security Settings Update 14202 For firms upgrading from PM86 SP2 or earlier, automatically assign securities 
created in PM87 using the agreed upon auto-assign rules 

  TF   

Security Settings Update 14609 The assignment of functional security options to a security role must include 
Date Created and Date Revised to support Web forms 

  TF   

Site Settings Bug 12620 Fix tab order and columns on Drive Mappings DE form   Tom   

Site Settings Update 10369 GMT/UTC Preparation Requirements for SP1 - GMT/UTC Site Settings.   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Site Settings Update 13762 Modify the Drive Mapping DE form   TF   

Source Code Bug 14586 Respect the Regional Options in timeslips and timeslip reports (same as 
PM80) 

  TF   

Source Code Bug 14817 Access violation at address 0046A257 in module 'PMWIN.exe'. Read of 
address 00000208 

AmFam Ingersoll, 
Andrea L 

Feedback 

Source Code Feature 14024 Add Publish Points to support Lotus Notes Integration   TF   

Source Code Update 10351 RealLegal Authentication Service 1.0 Requirment for SP1.   Tom   

Source Code Update 10355 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Source Code Update 10361 RealLegal Authentication Service 1.0 Requirement for SP1   Tom   

Source Code Update 10383 OCA Watch Requirements for PM 8.7 SP1.   Tom   

Source Code Update 11197 ISecurity interface and function AccessAllowed publishing.   Darius K; 
Tom 

  

Source Code Update 11198 TGridColors making a components.   Darius K; 
Tom 

  

Source Code Update 11199 DelTable making a separate COM object (module dll) which can be used with 
or without PMWIN. 

  Darius K; 
Tom 

  

Source Code Update 11201 Timeslip Settings (General Tab) + TimeSlips.GetRate publishing.   Darius K; 
Tom 

  

Source Code Update 11988 Fire set of PPs when entity was un-assigned from matter (NTFS integration 
requirement) 

  Darius K   

System Settings Bug 14711 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

System Settings Info 8241 In System Settings >General tab try to open Pmwin folder- have got an 
error:'I/O error 123'. 

  Dalia   

System Settings Update 9792 Portal Requirements for SP1.   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

System Settings Update 10368 GMT/UTC Preparation Requirements for SP1 - GMT/UTC System Settings.   Tom   

System Settings Update 10374 PCA 3.0 Requirement for SP1 - Implementing PCA Admin Setting Menu as a 
Standard Administration Menu Item in Practice Manager. 

  Tom   

TiffView Bug 14108 I just noticed that there is still logo and company name of law.com on the left 
side of %subj%. PM version is 8.7 SP2A. 

  Audrius   

TiffView Bug 14508 When close TiffViewer window, have got an error.   Rasa   

TiffView Bug 14639 In Window menu displayed not all of document's pages and order of pages is 
incorrect. 

  Rasa   

TiffView Bug 14729 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Timeslip DE Bug 10001 Problems with login to different sites   Dalia   

Timeslip DE Bug 14452 Receive “Warning, YOUR connection to the database dropped” message, 
when creating timeslip 

AmFam Mike G; 
Ken F 

Feedback 

Timeslip DE Bug 14661 Regional Options are not respected in following places.   Neringa   

Timeslip DE Bug 14718 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Timeslip DE Bug 14865 When an edit to the timeslips Status field is made, the "Rate" field is changed 
automatically and without warning or ability to avoid. 

  Lewis 
Kinard 

  

Timeslip DE Update 10939 Update billing export module accordingly   Donatas   

Timeslip DE Update 11416 PCA 3.1 Requirements for Chimborazo: Timeslips - Launch Timeslip Review 
on Timeslip Save. 

      

Timeslip DE Update 11417 PCA 3.1 Requirements for Chimborazo: Timeslips - Modify rate selection 
algorithm 

      

Timeslip Listing Bug 10661 Export Timeslips appears on Right-click menu even when it is not supposed to.   Ken   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Timeslip Listing Bug 10921 PMBILL_EXPORT module needs to be called with Application ID as 
parameter, not parent application id. 

  Darius K   

Timeslip Listing Bug 11657 Billing program is ex. QuickBooks 4.0. Open Timeslip listing. All timeslip 
already exported. Try to export. Timeslips details were exported, but only after 
got a message : No timeslips selected for export. 

  Dalia   

Timeslip Listing Bug 14013 Got an access violation error after archiving the timeslips.   Sigita   

Timeslip Listing Bug 14653 Regional Options are not respected in following places.   Neringa   

Timeslip Listing Bug 14683 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Timeslip Listing Update 11323 Update Timeslip Listing Quick Filter to be consistent with other Quick Filters.   Tom   

Timeslip Listing Update 11420 PCA 3.1 Requirements for Chimborazo: Timeslips - Modify Total button in 
Timeslip Listing to include logic for Adjusted Totals 

      

Timeslip Listing Update 11889 Add multi-select to the Timeslip Listing and update listing functionality to 
support it. 

  Tom   

Timeslip Settings Bug 12014 Problems with Timeslip Settings -> General -> Enable/Disable archiving   Sigita   

Timeslip Settings Bug 14687 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Timeslip Settings Feature 12712 In Timeslip Settings, move "General" to be in the first position   Tom   

Timeslip Settings Update 10379 PCA 3.0 Requirement for SP1 - Additional Rate Types.   Tom   

User Preferences Feature 14745 Add the ability to enable, select and position the ActiveX or Web browser form 
on the desktop views 

  TF   

Utility Bug 14429 PMTemplate convert utility problem with Corel8. Bowers 
Harrison 

Rasa 23879 

Utility Update 11361 Add functionality to conversion utility, implemented in PCR 9941.   Tom; 
Darius K 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow DE Bug 11261 Clicking on minimize button on Instructions for user screen should not minimize 
whole PM window (Matter->Overview tab->Critical Date screen-> Instructions 
for user) 

  Mike G   

Workflow DE Bug 13239 Workflow Administrators no longer have the ability to create templates( 
actions) on the fly when creating plans. 

      

Workflow DE Bug 13765 There is no way to get out of plan.   Ligita   

Workflow DE Bug 13798 PMWin Not responding when negative number is selected in Workflow 
Activities Schedule. 

  Ligita   

Workflow DE Bug 13813 In Appointment DE press on cowboy hat near Location field. Select one of 
entities from Entity Listing which is not Staff. Answer yes to assign as 
participant to activity. Add Entity DE Entity name faucet filter and OK button are 
disabled. 

  Ligita   

Workflow DE Bug 14125 Need to fix IWorkflow.NewItem interface implementation. It should not throw an 
error 'List index out of bounds(-1) if WF template ID is invalid 

  DK   

Workflow DE Bug 14250 Access violation, when entering a task into PM Wilkes & 
McHugh 

PSTANLE
Y 

Feedback 

Workflow DE Bug 14597 On Reschedule Event screen, "By" faucet filter doesn’t have right-click option 
Filter Field. 

  Mike G   

Workflow DE Bug 14651 There are several problems with copying Judge Address to the Location field in 
Court Event 

  Mike G   

Workflow DE Bug 14703 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Workflow DE Bug 14815 Access violation at address 00454E8A in module 'PMWIN.exe'. Write of 
address 0195C858 

Wilkes & 
Mchugh 

Carol 
Buckingha
m 

Feedback 

Workflow DE Bug 14826 Tasks scheduled for a weekend when they are not Wards Donatas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow DE Feature 14647 Add the ability to suppress the Status Change dialog box. This is both a 
System Setting and User Preference 

  TF   

Workflow DE Update 14831 Review functionality of In Progress 100%.   TF   

Workflow Listing Bug 12066 Change 'Time TO' to 'Time To'   Sigita   

Workflow Listing Bug 14388 If you remove Matter No column from the listing and save Grid layout, after 
closing and reopening PM column still displayed. 

  Mike G   

Workflow Listing Bug 14701 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Workflow Listing Bug 14759 Error message "QueryRule: Field 'MATPLANID' not found" when marking 
appointment Held 

  Lewis 
Kinard 

  

Workflow Listing Bug 14837 Receiving "Warning, YOUR connection to the database dropped" message Wilkes & 
McHugh 

Kim 
Mitchell 

Feedback 

Workflow Listing Update 13742 Multiselect>change status not always working   Ken   

Workflow Listing 
Hot Filter 

Update 11476 Update the Workflow Listing Filter   Tom   

Workflow 
Settings 

Feature 12714 In Workflow Settings, add new "General" tab in the first position and move all 
workflow-specific system settings to that tab 

 Tom  

Workflow 
Settings 

Bug 14705 User should not be able to minimize Modal dialog. The list of modal screens 
attached. 

  Rasa   

Workflow 
Settings 

Bug 14868 Spelling error on confirmation message in Workflow Settings:Activity Type tab   Mike G   

 

7. Scope – Inclusions – Duplicates 

This report is taken from the PCR Database.  It is all PCRs in Pumasillo that, as of March 21, had a status of On Hold, Under Review Pending, 
Done or Final, that are duplicates of work carried out in PM87, PM87 SP1, PM87 SP2, and PM87 SP2A that occurred after the Chimborazo 
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code split in August of 2002.  This is a fixed list of replicated PCRs, and is not subject to updating.  As of this date, all these PCRs have been 
Done and are awaiting final testing from QA. 

The report is first sorted by Area, then Type and then ID. 

There are additional fields available when this report is accessed from the PCR Database.  Note that the links currently point to Thunder.  This 
is only available if you connect to the PCR Database from the Lithuanian office or from the VPN.  At the time this report was generated, there 
as no quick way to correct this.  Future updates should have this corrected. 

 

Area Type ID Description/Comments Site Contact Support 
Tickets 

Components Bug 14199 Use “No.” consistently throughout PM (right now we have “#” and “Number”).   Mike G   

Components Bug 14413 When trying to resize Select Visible Columns screen, it changes screen size 
but doesn't actually resize Avaliable Fields and Selected Fields. 

  Mike G; 
Ken F 

  

Components Feature 3125 Write new TPrintQuery component descendent from TQuery with overriden 
methods for Calculated fields adding by using our TFilterQueryPM component. 

      

Components Update 8248 All PM lookups- When activated-a blank box apears in the system taskbar.   Ken   

Components Update 13748 With WinXP, there is a problem with minimize, restore windows. Patten Ken   

Database Bug 10918 RLEnterprise integration with PM: There are not refreshed assignments when 
changing entity role. 

  Vitalius   

Database Bug 10947 RealLegal.DataService.udl storing the SA login pass on every Client machine 
open the udl in Notepad I can see the SA password. 

  Ken   

Database Update 12082 up86to87.sql prints 'Upver script finished.' before it really is. See comments   Ken   

Desktop Views Bug 13669 Spelling error: message reads "Please go to Edit – Preferences – Views, and 
selected". Should be “select” 

  Mike 
Girenko 

  

Document 
Assembly 

Bug 12376 DB=Glasser87.Engine=Word97. Merge new document with doc asm 
component. All field are merged. Leave generated file opened. Create another 
document and use the same doc asm component. Merge. There are some 
fields not merged in this document 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Bug 12522 When you create a document using a template (Template A) (Word XP 
template) and leave it open in Word. Then, if you create another document 
using Template A, if you do not actually close the first document, you will get 
an error. 

  Richard; 
Mike G 

  

Document 
Assembly 
Settings 

Bug 14148 Document Component Design screen: with Win XP theme and 800x600 
resolution, Aux label gets cut off (see screenshots) 

  Mike G   

Document 
Assembly 
Settings 

Bug 14150 Document Assembly Settings:Assignment tab – with Win XP theme and 
800x600 resolution “No Assignments (DocTypes Only)" label gets cut off 

  Mike G   

Document 
Assembly 
Settings 

Bug 14152 Date Formatter screen (Document Assembly Settings: Option tab)-spelling 
error "Description and EXMPLE". Should be "Example" 

  Mike G   

Document DE Bug 12602 Create new document profile. Enter Description, Primary Matter (use '_rm 
matter'), Author and hit Tree button. Wait for a few seconds. Pmwin crash. 
Tested on Glasser872 db. 

  Rasa   

Document DE Bug 13782 Open document profile. Click on List Versions button, click on Delete button (it 
is enabled), have got message 'Cannot delete the latest document version' 
(that's ok). Then double click on item, now Delete button is disabled. 

  Rasa   

Document DE Bug 13783 1) Open Document Versions screen (Profile DE> List Versions button) . When 
file does not exist, maybe Open Document button should be disabled like in 
Profile DE? 

  Rasa   

Document DE Feature 14566 Add Check out/in functionality to documents.   TF   

Document DE Update 14096 Entities Tab in document profile and assignments. See comments   Ken 25741 

Document Listing Bug 10297 When drive mapping is not setuped, when opening files from another site PM 
in some cases does not give message "Drive mapping does not exists.." but 
tries to open document in local drive according to original document path. 

  Daiva   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document Listing Bug 12098 When I created profile (using template) and saved it, after I tried to open this 
profile(double-click), I get "..file is not found. The document may not have been 
created.. "message. I can open this profile if I right-click on it and choose "view 
profile" 

  Mike G   

Document Listing Bug 13640 When open word document from Document listing, on Task Bar see that the 
first 'Document1' is opened, it disappear and after PM document opened. 

  Rasa   

Document Listing Bug 13788 The messages when file is not founded:   Rasa   

Document 
Settings 

Feature 11241 "File Extention" field should be autopopulated, after user entered "Application 
Name" (Document Settings->Application tab->New Application Screen) 

  Mike G   

Documentation/M
anuals/Help 

Update 13997 Update PMRemote manual   Aurelija   

Encryption Update 9087 Implement new encryption in each of our applications.   Ricky   

Entity Assign Update 12150 When assigning an entity to a matter, only show roles for which the entity is not 
assigned to the matter. 

  Tom   

Entity DE Bug 10753 It is possible to create an entity as Both a USER and WEBONLY. Web Only 
should not allow the selection of USER and Vice Versa 

  Ken   

Entity DE Bug 11903 Wrong message form when assigning dublicated entity in Entity de :Tree   Vaidas   

Entity DE Bug 12308 When the upgrade scripts were run (upgrade from 8.0.78 to 8.7.31), address 
descriptions were removed from the addresses. Every time a user goes into an 
entity record, they are required to enter an address description. 

Shriners - 0209 Tom 23115 

Entity DE Bug 13810 New DE forms created from Entity Related Tree view are opened behind the 
Entity DE window. 

  Ligita   

Entity DE Bug 13812 When clicked Copy on Assign/Copy Parent Address screen the same address 
copied twice to the child entity 

  Mike G   

Entity DE Bug 13819 Hourly Billing Rate screen-OK and Cancel buttons get cut off, when Display 
Properties:Theme set to WinXP (800x600 resolution) 

  Mike G   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity DE Update 11227 The Entity Title pull down list (Prefix) should be filtered by the Entity Gender 
choice (Entity's General tab) 

Lewis Kinard Lewis; 
Mike G 

  

Entity Listing Bug 14214 Go to Global Matter listing, make first column in focus > type-search anything > 
click Escape button and go to Global Entity listing until Matter Listing is not 
refreshed > make first column in focus > type-search anything. 

  Arunas   

Entity Settings Bug 14054 Go to Address Description tab > click New > enter new address description 
and click Enter > system asks if I really want to cancel. Usually clicking Enter is 
accepted as clicking OK, not Cancel. 

  Arunas   

Entity Settings Bug 14438 Role Assignment Filter – “Side” checkboxes do not respect Law Type or Role 
settings 

  Mike G   

Entity Settings Update 14242 In new database ENNTYPE.SHOWLINKEDTO is NULL for "Other" type, 
therefore Show Employer/Parent organization checkbox is grayed in Entity 
Type DE 

  Donatas   

Form Designer Bug 14748 For Designer screens and Minimize buttons.   Rasa   

General Bug 14146 Record ID should be added to the following listing as available column (see 
comments) 

  Mike G, 
Ken F 

  

Groupware DE Bug 9914 Groupware by using Groupwise. Creating a Phone message.   Daiva   

Groupware DE Bug 9917 GW6: trying to drag e-mail which is attached to another e-mail, in "Choose 
Matter to Import Groupware Item to" screen click Close, get error: 'GroupWise 
Error - Token failed execution! ItemListCreateFromControl' 

  Donatas   

Groupware DE Bug 14235 Message displayed when user does not has access to his e-mail folders is not 
entirely correct. 

  Donatas   

Groupware DE Feature 8594 I want to file our request for having an option in groupware that allows either 
"File No." or "Matter No." to be auto-generated in the message/task subject 
line. 

AMFAM - 0100     

Groupware 
Listing Query 

Update 13277 In Groupware Listing Query some of query fields are in all capital letters: 
BEGINTIME, CLIENTNUMBER, ENDTIME, MATTERNUMBER. 

  Ligita   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Guideline Bug 14390 Review ability to check/uncheck "Public Template" checkbox on templates 
within Admin settings 

  Mike G   

Imageview Bug 13792 There is no Scanner. Open document with Image Viewer, select Scan menu> 
Pager, check any radio button and hit OK. Have got error screen without any 
text, just OK button. 

  Rasa   

Imageview Bug 14114 Run ImageViewer without Pmwin. Enter Login name which not exist, hit OK, 
have got 'Invalid object names 'Entities''. 

  Rasa   

Imageview Bug 14116 Run ImageViewer without Pmwin. Hit Cancel in Login screen, have got an 
access violation. After that ImageViewer runs and all buttons are enabled. 

  Rasa   

Imageview Bug 14118 Rum ImageViewer without pmwin. Not enter anything in login screen and hit 
OK, have got 'Parameter object is improperly defined. Inconsistent or 
incomplete information was provided'. Hit OK, have got access violation. 

  Rasa   

Imageview Bug 14133 Run ImageViewer without Pmwin. Incorrect tab order in Login screen. Should 
be 1-Login, 2-Password, 3-OK, 4-Cancel. 

  Rasa   

Imageview Bug 14135 Run ImageViewer without PM (go to <root>\ImgView\ and double click on 
imgv32.exe). ImageViewer connecting to default database of SQL Server user. 
Maybe Viewer should be taken the connection from pmwin.udl? 

  Rasa   

Imageview Bug 14155 OCR from Image Viewer:   Rasa   

Imageview Bug 14222 Open document with ImageViewer. Go To File menu and select Close Image. 
Document is closed. Then hit on Next/Previous Page button. Have got 'Login 
failed for user'' '. 

  Rasa   

Imageview Bug 14514 From PM create document with ImageViewer. When Viewer window opens, 
minimize it and hit again Open Document button in Document Profile DE. 
Return to ImageViewer window. The document is closed and have got an error 
'Login failed for user'. 

  Rasa   

Imageview Update 9856 I open the same TIF file by using Tiff Viewer and Image Viewer. Tiff Viewer 
shows that my file contains 13 pages, Image Viewer - only 5. 

  Daiva   

Install/ Upgrade Bug 14072 Review PM uninstall/install. Seems like it doesn't remove/update all files.   Mike G   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Install/ Upgrade Bug 14073 Review PM uninstall/install. Seems like it doesn't remove/update all files.   Mike G   

Install/ Upgrade Update 10991 Include execution of utility developed for PCR 9305 in a standard upgrade.   Tom   

Legal Vision 
Integration 

Bug 8293 In 8.0 create a client.This client posted to Legal vision. After in 8.6> Timeslip 
settings> general tab>Synchronize data sets synchronize clients - this just 
created client in 8.6 will be like organization, not like individual. 

  Dalia   

Legal Vision 
Integration 

Bug 8347 In Timeslip listing you will not see all timeslips with deleted task code. Must 
synchronize this deleted task code from Legal vision if you want to see all 
timeslips. 

  Dalia   

Legal Vision 
Integration 

Bug 8360 In Timeslip listing>Profile tab hit on 'A/R Inquiry' button. Maximize A/R Inquiry 
screen- screen is maximized not correctly. 

  Dalia   

Legal Vision 
Integration 

Bug 8361 In Timeslip listing using right click hit on 'In last days>Other. In Enter data 
screen enter value 1000. Hit on 'Ok' button. Have got an error:'Non-nullable 
column be updated to NULL'. 

  Dalia   

Legal Vision 
Integration 

Bug 11225 Timeslip entry is not working from PM to LV. Automation error appears. Also 
automation error appears if try to enter bad user name or password in Login to 
LV screen. 

  Dalia   

Legal Vision 
Integration 

Bug 11282 In any listing hit on 'Retrieve Filter or query' using right click. If Filter list screen 
is empty try to enter any record in Search field>Filter List screen. Have got 
access vioaltion error. 

  Dalia   

Legal Vision 
Integration 

Bug 11285 Synchronization from PM to LV if Timekeeper match field is 'ID'.   Dalia   

Legal Vision 
Integration 

Bug 11288 Timekeeper match field is 'Timekeeper number'.   Dalia   

Legal Vision 
Integration 

Bug 11289 Entering bad user name or password into Login to LV screen.   Dalia   

Legal Vision 
Integration 

Bug 11291 Matter Synchronization from Legal Vision To PM is not working   Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Legal Vision 
Integration 

Bug 11530 Unassign timekeepers in PM is not unassigning timekeepers in LegalVision       

Legal Vision 
Integration 

Bug 12748 LV rates are populated in timeslip DE, but in timeslip appears rate if last rate 
was entered ex. in 2001/10/12 and user create timeslip ex. 2002/10/12. In This 
situation rate must be 0. ( the same in 8.0) 

  Dalia   

Legal Vision 
Integration 

Update 11837 Add support for LegalVision 11   Tom   

Mail Merge Bug 9916 In document assembling generate mailing label (not envelope) template (use 
MS Word2000 or Word97). After merge five or more entities with this template. 
When view 'Print Preview' in word, the information of each entity is placed not 
in individual page . 

  Rasa   

Mail Merge Bug 13815 Mail listing screen opens with scroll bars   Mike G   

Mail Merge Bug 13817 Tools: Mailing Lists: Assign Lists or Assign Entities tabs-column headings 
should be loaded, when you open this listings first time 

  Mike 
Girenko 

  

Mail Merge Update 11478 W97convert.exe utility does not convert Address templates to Word 2000 or 
Word XP. 

  Daiva   

Matter DE Bug 10759 Can't open security tab.   Vaidas   

Matter DE Bug 10816 Error message: Failed to load PCA_MATTERINFO.OCX   Vaidas   

Matter DE Bug 11223 Cannot see all PCA matter fields in PCA matter DE> general tab, if PC 
resolution is 800 x 600 

  Dalia   

Matter DE Feature 13971 Increase size of Matter Search Name to 100 characters Shriners 0209 Cynthia K; 
Mike G 

  

Matter Listing Update 11234 Change "Age" label to "Matter Age" label (Matter Listing Overview tab)   Mike G   

Matter Listing Update 11334 Change the caption on the matter screen for the Open & Closed check box 
from Status to Category. 

Wilkes & 
McHugh - 0244 

Cynthia K   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter:Issues Bug 14437 1.If open issue from matter:issue tab, it is not matter specific. If open the same 
issue from entity:related tree tab, it is matter specific. 

  Rasa, Ken 
F 

  

Matter:Issues Update 13667 Review the matter-specific issue functionality   Donatas   

Matter:Workflow Bug 13408 Access violation reported by Ward Haddaway Ward Hadaway 
- 0250 

Donatas 22207 

Note Listing Bug 10833 Note info never is empty   Vaidas   

Phone Call DE Bug 13740 When creating New Phone Message from entity global listing Phone Message 
DE form opens with no current user selected in the User field 

  Mike G   

Printing Bug 14655 Access violation when "printing" Bacon&Wilson Karen L. 
Kennedy 

Feedback 

Printing Bug 14656 Access violation when "printing" Bacon&Wilson Karen L. 
Kennedy 

Feedback 

Query Bug 13749 When Query open and you choose Date of Birth, when you delete last digit and 
click Apply, you receive "The conversion of a char data type…" message 

  Mike G   

System Settings Bug 13758 When time separator in system settings is changed to /,and I am trying to 
change time of existing Phone Call, I am getting "Entered date is not valid in 
SQL server" error. 

  Mike G   

System Settings Bug 13804 Go to System Settings > Click Date /Time Format Field cowboy hat button > 
Time Formatter window appears. I see Date Format before Time format in 
Time Format window. This should not be so - there must be only Time Format. 

  Arunas   

System Settings Bug 14112 The matter numbering system is going haywire, creating matters with duplicate 
numbers since the year rolled over. LSNT has Matter Numbering in 
"Interactive" mode with annual recycle selected 

LSNT Josh 
Berlin 

24325 

System Settings Update 13472 Add new Preference: Open Document O Maximized O Normal   Tom   

System Settings Update 13473 Add new Preference: Open Document O Maximized O Normal   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

TiffView Bug 14121 Run TiffViewer without Pmwin. Enter Login name which not exist, hit OK, have 
got 'Invalid object names 'Entities''. 

  Rasa   

TiffView Bug 14126 Run TiffViewer without Pmwin. Hit Cancel in Login screen, have got 'No such 
interface supported'. After that TiffViewer runs and all buttons are enabled. 

  Rasa   

TiffView Bug 14129 Run TiffViewer without Pmwin. Enter Login\Password, hit OK, have got 'No 
such interface supported'. After that TiffViewer runs. 

  Rasa   

TiffView Bug 14131 Run TiffViewer without Pmwin. Incorrect tab order in Login screen. Should be 
1-Login, 2-Password, 3-OK, 4-Cancel. 

  Rasa   

TiffView Bug 14137 Run TiffViewer without PM (go to <root>\ImgView\ and double click on 
imgv32.exe). TiffViewer connecting to default database of SQL Server user. 
Maybe Viewer should be taken the connection from pmwin.udl? 

  Rasa   

TiffView Bug 14224 Open document with TifViewer. Go To File menu and select Close Image. 
Document is closed. Then hit on Next/Previous Page button. Have got L'ogin 
failed for user'' '. 

  Rasa   

TiffView Bug 14511 From PM create document with TiffViewer. When TiffViewer window opens, 
minimize it and hit again Open Document button in Document Profile DE. 
Return to TiffViewer window. The document is closed and have got an error 
'Login failed for user'. 

  Rasa   

Timeslip Listing Bug 11127 When you export timeslips and mark them exported, the screen does not auto-
refresh after the export is completed. 

  Mike G   

Utility Bug 12261 On Glasser db, pmtemplate will not work. Version - 8.7.31 ( latest macros and 
template from release site) 

Glasser & 
Glasser - 0185 

Tom   

Workflow DE Bug 11274 By changing plan's matter it is possible to insert plan into matter, to which law 
type plan was not assigned 

  Donatas   

Workflow DE Update 11813 Workflow Listing -> New Task -> Entities tab -> Address and Entity Note areas 
should not be resizable. Right now user can resize it horizontally, like regular 
column 

  Mike G   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow 
Settings 

Bug 14321 Activity Type drop down list has a spelling error.   Mike G   

Workflow 
Settings 

Bug 14456 Workflow Settings: Activity Templates tab-Type column should be renamed to 
Category 

  Mike G   

 

8. Scope – Exclusions 

This report is taken from the PCR Database.  It is all PCRs in Pumasillo that, as of March 21, had a status of Not Applicable or Deferred.  This 
list is subject to update, and the PCR Database always represents the latest and greatest version of this report. 

The report is first sorted by Area, then Type and then ID. 

There are additional fields available when this report is accessed from the PCR Database.  Note that the links currently point to Thunder.  This 
is only available if you connect to the PCR Database from the Lithuanian office or from the VPN.  At the time this report was generated, there 
as no quick way to correct this.  Future updates should have this corrected. 

 

Area Type ID Description/Comments Site Contact Support 
Tickets 

Auxiliary Settings Bug 12251 Right click on auxiliary is not working for any EXE specific auxiliary "specifically 
entity". 

Glasser & 
Glasser - 0185 

Ricky   

Components Bug 11314 In some filter selection screens, when type search by any character, search 
window is blinking. 

  Rasa   

Components Bug 13391 Memory leak in TDBGridPM.MouseDown method   Arturas   

Components Bug 13513 Tested on Glasser87 db on LTDEVSQL2. Open any record containing date 
field (date format on Glasser87 is YYYY-MM-DD) > enter eg. 2005-01-01 > try 
to save a record or to go to other field > get an error:"'2005--' is not a valid 
date.". 

  Arunas   

Components Bug 13614 Calendar week view have not released all resources   Saulius   

Components Update 11099 Remove hardcoded Limit of 20 item seletion in Filter selection screens.   Ken   

Components Update 11820 Implement separate command line switch for PMWIN COM Object registration   Darius K   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Components Update 13290 From components TFilterLookupButtonPM and TCalendarButtonPM destructor 
remove DeleteObject(Glyph.Handle). 

  Arturas; 
Saulius 

  

Components Update 13324 Bad exception handling in TADOQueryPM.Post method. There was ability to 
produce Acces Violation 

  Saulius   

Components Update 13377 TTreeViewPM componet has a memory leak: it does not free items when 
beeing destroyed 

  Arturas   

Database Bug 9973 Restored 8.0 database does not has Site Security enabled - after upgrade to 
8.7 records are creted in SITESEC table assigning each user to their default 
site. As a result it is not possible to enable Site security in upgraded database. 

  Donatas   

Database Bug 10801 Upgrade problem.   Saulius   

Database Bug 10908 Review All 8.0 sql scripts for compliance. upg_prep80 upver038.sql is not 
SQL2000 compliant because quoted identifiers is on by default. See 
comments. 

  Ken   

Database Bug 10953 Add to upgrade script a script to trim spaces out of addresses   Ken; 
Donatas 

  

Database Bug 11007 Add these changes to SQL scripts   Donatas   

Database Bug 11171 Add Client Phone to ListingID=3   Tom   

Database Bug 11511 Remove available fields from LSTDEF that cause records to appear more than 
once 

  Tom   

Database Bug 12013 Error occurs in up87sp1 stored procedure PM_Compact_Addresses if address 
line has apostrophe symbol in it. CREATE PROCEDURE 
[dbo].[PM_Compact_Addresses] 

  Robertas   

Database Bug 12249 Seems like we are experiencing deadlocks Glasser & 
Glasser - 0185 

Ricky 23070 

Database Info 13781 Sign in as SA, open up a users entity record. The users code greyed out and 
cannot be changed 

0257 Legal Aid 
Bureau, Inc 

Jason 24200 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Database Update 10810 Rebuild the Upgrade program with updated scripts by Saulius (PCR 10801).   Tom   

Database Update 10812 Write an upgrade utility, related to 10801.   Tom   

Database Update 11178 Increase length of the CMPNFLDS STOREPREFIX to VARCHAR(50) in order 
to prepare for longer. 

  Darius K   

Database Update 11671 When upgrading, include populate the Event/Due Date with the completion 
date for any completed workflow items where the Event/Due Date is null 

  Tom   

Database Update 12006 Update indexes on MRULASS table   Darius K   

Database Update 12073 Create and index on MRULASS.ADMINID   Darius K   

Database Update 12297 Add a clustered index on mrulent that includes entityid and threadid in that 
order. 

  Ricky   

Desktop Views Bug 10493 In User Preferences is checked Default PM Desctop =Two Party, open 
Desctop, hit on 'Calendar for' faucet filter and extract available list, after hit on 
the any link (when the list is still extracted), have got access violation. 

  Rasa   

Desktop Views Bug 10548 Access violation When open Workflow Item.   Vaidas   

Desktop Views Bug 10551 In User Preferences is checked Default PM Desctop =Two Party, open 
Desktop: 

  Rasa   

Desktop Views Bug 12535 Enable Desktop View -> User Preferences -> choose default PM View - PM 
Desktop -> disable Desktop View - it still launches. 

  Sigita   

Desktop Views Bug 12537 Got an error while launching pmwin and then it closes.   Sigita   

Desktop Views Bug 12596 User has not 'Open Desktop View - Manager', 'Open Desktop View - Single 
User', 'Open Desktop View - Two-Party" functional securities. Go to User 
Preferences> Views tab Desktop options are enable. 

  Rasa   

Desktop Views Update 11998 Update Desktop Views to respect System Setting for Ticklers (implemented in 
11841) 

  Donatas   

Desktop Views Update 12295 Change Desktop Views into a firm-wide option   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Bug 10592 Site Security is on. Create doc assm template with some Entity Type or Entity 
Role Auxiliaries fields. Generate document with this template 

  Rasa   

Document 
Assembly 

Bug 10956 Spaces in address lines are treated as valid for doc assembly. I'm pretty 
certain that this was not the case in prior versions and needs to be changed 
back. 

  Donatas   

Document 
Assembly 

Bug 11012 Document Assembly Merge -- Progress indicator reads "Processing Mail 
Merge" from Generate Doc. It should read "Merging Document" as a nice, 
generic label. 

  Donatas   

Document 
Assembly 

Bug 11014 Document Assembly Merge -- Upon completion of merge with Corel WP2002, 
a dialog appears that reads "MacroFilePlay." It does not appear to impact the 
merge, but it is annoying. 

  Tom   

Document 
Assembly 

Bug 11602 From Word97 can not to invoke a window that lists PM fields, when is installed 
HotDocs application. 

  Rasa   

Document 
Assembly 

Bug 11604 OLE merge with MS Word97. OleMerge macro isn't autoruning.   Rasa; 
Daiva 

  

Document 
Assembly 

Bug 11618 Document Assembly - Options. When is cheched 'Include Entity Role' in 
Signature Block, Pleading Signature Block or COS Blocks and String, role is 
not retrieved in generated document. 

  Rasa   

Document 
Assembly 

Bug 12135 Upgrade issue with Document Templates   Tom   

Document 
Assembly 

Bug 12177 Document creation and opening of Word XP Patten - 0206 Ken; Mike 
G 

22940 

Document 
Assembly 

Bug 12301 On Glasser db, when generate document with some doc assembly templates, 
the info is not retrieved in some fields (Use components 'F-Bidding Instruction 
Fax from Client for Bid Only' or 'F-Fax to client contact re backuptcy info') 

  Rasa   

Document 
Assembly 

Bug 12441 When doing document merge, if user chooses to skip component during 
merge, Merging process loops. 

  Darius K   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Bug 12450 Boilerplates are a <<Doc1.doc>> ctually showing as assigned templates in this 
situation. There are no templates with this naming convention 

Shriners - 0209 Ken   

Document 
Assembly 

Bug 12460 If any kind of error is thrown during document assembly that prevents the 
merge, close opened Word windows 

  Tom   

Document 
Assembly 

Bug 12524 Existing OLE queries lose field type in conversion from 8.0 to 8.7 Patten - 0206 Ken   

Document 
Assembly 

Bug 12540 Get error when trying to use OLE merge with Word Patten - 0206 Ken   

Document 
Assembly 

Bug 12554 When merge document and use doc assembly component with _NoteDesc 
and _NoteText fields, the same info retrieved in both fields (that is a description 
of the note retrieved in both fields) 

  Rasa   

Document 
Assembly 

Bug 12579 I have doc assm component with all note fields for all groups. Merge document 
with this template. Select multiple addressee entities. The fields CC_NoteDesc, 
BCC_NoteDesc… for the first addresee entity retrieves correct, but for the 
second - incorrect 

  Rasa   

Document 
Assembly 

Bug 12581 Word displays 'File in Use' message when one user has opened component in 
Design mode, and other is trying to merge a document using same component 

  Tom   

Document 
Assembly 

Bug 12585 I have doc assembly template with all note fields (_NoteDesc, _NoteText) from 
all groups. Generate document with this template. All selected entities have at 
least two notes.There are not invoked Note screens of BCC, Plaintiff, Entity 
Type groups in the 

  Rasa   

Document 
Assembly 

Bug 12901 Keyboard prompt hides behind the word window when performing document 
merge 

Shriners - 0209 Ken   

Document 
Assembly 

Bug 13436 Access volation got when cancel document profile while generating document.   Ligita   

Document 
Assembly 

Bug 13517 Error when assigning entities in Addressee/CC/BCC Pick Screen   Aurelija   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Bug 13556 During merging a document, while gauge is processing, click on any button or 
tab. Have got AV 

  Aurelija   

Document 
Assembly 

Bug 14278 When you merge a document with more than one role and include the bar 
number field, only the bar number for the first entity with the first role is being 
pulled in 

AmFam TF   

Document 
Assembly 

Bug 14280 When you merge a document with more than one type field group and include 
the bar number field, only the bar number for the first entity with the first type is 
being pulled in 

AmFam TF   

Document 
Assembly 

Info 10993 CMPNASSN.ISDEFAULT field got a value of ‘T’ on all the records but 
document profile forces the user to pick components anyway. Only post-
upgrade combination assignments behave in document profile. 

0031; 0033; Donatas 0031-2552 

Document 
Assembly 

Info 12558 Nestform Command forces the merge code to wrap to the next line. It seems to 
be putting a hard return in to the code. When the nestform command wraps it 
will not merge in the desired component 

Patten - 0206 Mike G   

Document 
Assembly 

Info 14343 When making a copy of a document the Document Profile screen will 
sometime have buttons grayed out. 

Bacon & 
Wilson 

Mike G 25997 

Document 
Assembly 

Info 14578 Receive Message "Word cannot open this document template" when trying to 
open fax template in forms. 

AmFam Mike G Feedback 

Document 
Assembly 

Update 11360 Update existing macros that are being attached with newly created template, 
so that window that lists fields during design time would at least have 
scrollbars. 

  Tom   

Document 
Assembly 

Update 11389 Update component conversion replacement change sets for PCR 
[11381/11382]. 

  Tom   

Document 
Assembly 

Update 11391 Update component conversion utility for PCR [11381/11382].   Tom   

Document 
Assembly 

Update 11398 Update component conversion replacement change sets for PCR 
[11379/11380]. 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly 

Update 11400 Update component conversion utility for PCR [11379/11380].   Tom   

Document 
Assembly 

Update 12305 Write a conversion script that populates the ASMENGINEID with the ID of the 
current selected Default Engine when ASMENGINEID=<null> or 
ASMENGINEID=0. This basically puts the database in a state where the 
condition corrected in 12302 can no longer exist 

  Tom   

Document 
Assembly 

Update 12994 Remove the copy of the components AFTER the merge has been successfully 
completed 

  Tom   

Document 
Assembly 

Update 13241 All property fields for the blank components should be null   Tom   

Document 
Assembly Design 

Bug 11182 Change component name creation so that it would correspond warning that is 
being displayed when there is Entity Type or Role selected which exceeds 25 
characters. 

  Darius K   

Document 
Assembly Design 

Bug 12385 After upgrade from SQL7 to SQL2000 Database Command for pulling 
information from EXE Auxiliaries is not working 

Glasser & 
Glasser - 0185 

Cynthia K   

Document 
Assembly Design 

Info 11584 Copying of some old FRM file contents to old document assembly template, 
may cause problems for template convertion utility. 

  Daiva   

Document 
Assembly Design 

Update 10932 Create utility for converting field names in document assembly components 
using macros from 8218. 

  Donatas   

Document 
Assembly Design 

Update 11180 Change Document Assembly Component Design screen functionality so that 
when Entity Type or Entity Role group fields are being assigned to component 
field name would include Entity Type or Role ID in it. 

  Darius K   

Document 
Assembly Design 

Update 11327 When generate doc assembling component, in word processor 'PM Document 
Assembly Component...' screen need to add Horizontal Scrollbars, because 
not all field description is visible. 

  Rasa   

Document 
Assembly Design 

Update 11380 Implement new FieldKeys from pm8725.fields.rev1.xls.   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly Design 

Update 11382 Implement new construction method for ET and ER prefixes.   Tom   

Document 
Assembly Design 

Update 11450 When creating prefix for an Entity Type or Entity Role with long description, 
show warning message 

  Tom   

Document 
Assembly Design 

Update 11633 From PCR 11379: the following fields left with original names: LastReview, 
LastUpdate, MatterType, ParentOrg. 

  Daiva   

Document 
Assembly Design 

Update 12303 Remove Default as an option for Engine on the Design screen, and only list the 
actually word processors that can be used -- it should default to the current 
selected Default Engine 

  Tom   

Document 
Assembly Design 

Update 12434 When a user changes the Default Word Processor for Assembling on the 
Document Assembly Settings - Options tab, AND the change was to another 
version with the same word processor "family" (e.g., Word or WordPerfect) 
handle the functionality as follows 

  Tom   

Document 
Assembly Merge 

Bug 10173 Document merge - Adressee/CC/BCC Pick screen. Assign all columns to 
Entities grid, make active Role column and type search, have got 'Incorrect 
syntax near the keyword 'ORDER'' 

  Rasa   

Document 
Assembly Merge 

Bug 11697 When I do OLE merge with Corel 8, get error from "WPWin Error" - 
Unsupported file format detected. But document is merged ok. 

  Daiva   

Document 
Assembly Merge 

Bug 12247 Some auxiliary fields are not merging in the foreclosure department Glasser & 
Glasser - 0185 

Ricky   

Document 
Assembly Merge 

Bug 13465 An AV message appeared when I tried to generate a document.   Sigita   

Document 
Assembly Merge 

Bug 13597 Access Violation error when merge a document   Rasa   

Document 
Assembly Merge 

Bug 13606 Got an AV error closing PMWIN.   Sigita   

Document 
Assembly Merge 

Bug 14092 The problem with HotDocs.   Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document 
Assembly Merge 

Bug 14249 The problems with HotDocs.   Rasa   

Document 
Assembly Merge 

Bug 14347 When you merge a document with more than one role and include the note 
fields, only the note for the first entity with the first role is being pulled in. 

  Rasa   

Document 
Assembly Merge 

Bug 14349 When you merge a document with more than one type and include the note 
fields, only the note for the first entity with the first type is being pulled in. 

  Rasa   

Document 
Assembly 
Settings 

Bug 11483 I open template of "Old All" type, click save - some error message appears, 
and template is saved of "Address" type. 

  Daiva   

Document 
Assembly 
Settings 

Bug 11873 When delete a component from Document Assembly Settings> Components 
tab, have got an error. 

  Rasa   

Document 
Assembly 
Settings 

Bug 12468 When you remove a document type assignment from document settings 
(DOCTYPAS), you should also remove the document component assignment 
from that combination (CMPNASSN). 

  Ricky   

Document 
Assembly 
Settings 

Bug 12470 Document Assembly Settings : Assignment : Doc Types with No Defaults is not 
filtering the list properly 

  Tom   

Document 
Assembly 
Settings 

Update 10992 Create utility - go through all document assembly components and do a search 
and replace on field codes, replacing old codes with the new ones. Upgrade 
both the database AND the files, themselves. 

  Tom   

Document 
Assembly 
Settings 

Update 12478 Add script to create defaults in COMPASSN for each DOCTYPAS with an 
assignment 

  Tom   

Document DE Bug 10147 Open document profile, save this profile as template (View> Save as 
Template), enter Template Code, Description, hit Save Template, nothing 
happens. Then hit Cancel Template, have got access violation. 

  Rasa   

Document DE Bug 10151 In profile only document hit Groupware button - get an error message "Invalid 
variant type conversion" 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document DE Bug 10179 In Document DE hit Author cowboy hat button. In Entity Listing screen select 
Matter Client right click menu item (or select Matter Client from View menu), 
have got an error 'The column prefix 'ASSIGN' does not match with table name 
or alias name used ...' 

  Rasa   

Document DE Bug 10234 An error when split image which is located in another computer.   Rasa   

Document DE Bug 10236 Drive mappings - copy a document, have got an error '... file is not found. The 
document may not have been created or may have been deleted.' 

  Rasa   

Document DE Bug 10597 When opening a HTML document, get "File not found". Should open the 
specified link. 

  Daiva   

Document DE Bug 11333 When generate document with Tiff Viewer, have got an error 'Invalid column 
name 'INTEGRATIONID'' 

  Rasa   

Document DE Bug 11412 When the first time go to document de auxiliary tab, have got an error 
message, but when the second time go, no message is displayed, just empty 
tab. 

  Rasa   

Document DE Bug 11702 Any fields that are not visible on the profile (eg. Profile only document) should 
not be populated from the template. 

  Arunas   

Document DE Bug 11895 When drag image document with file name having two or more '.' symbols (for 
ex: 'picture.used.testing.tif), then after clicking Open Document, I get an error 
'C:\101\CAT-1\picture.TIF is not recognized' and opens empty Image Viewer 
screen. 

  Rasa; 
Donatas 

  

Document DE Bug 12330 Problem with document merging. Create a new document, check' Assemble 
Document with Practice Manager' or 'Skip Document Assembly', hit Generate 
Document. Have got a message. Document is not generated. 

  Tom   

Document DE Bug 12414 All of Glasser's document profile templates were changed to "choose 
fromIndividual components" radio button selected in the 8.7 upgrade. 
Thecorrect radio button should be "choose from Global assignments" 

Glasser & 
Glasser - 0185 

Ken 22297 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document DE Bug 12416 Two problems: Versions listing does not list the original document, only the 
new versions and Version numbering is:original: .docversion 1: 
.a01.docversion 2: .a01.a01.docversion 3: .a01.02.docshould be .a01.doc, 
.a02.doc, .a03.doc, etc. 

Glasser & 
Glasser - 0185 

  22927 

Document DE Bug 12611 When copy a document profile which has checked Version Control option, two 
documents are created x.a01.doc and x.a01.doc. Should be x.doc and 
x.a01.doc 

  Darius K   

Document DE Bug 13294 There is still a problem with copy document functionality when changing 
matters 

0206 Patten Ken 24671 

Document DE Bug 13367 Error 'The column prefix 'ASSIGN' does not match with a table name or alias 
name used in the query.' in Document DE Assign Entities screen 

  Donatas   

Document DE Bug 13382 Can generate document without Type.   Aurelija   

Document DE Bug 13452 Access violation reported by Shriner       

Document DE Bug 13458 Document DE error and Winword error   Donatas   

Document DE Bug 13498 When try to assign the same entity with different roles to the document, have 
got an error 'Cannot insert duplicate key row in object 'DOCENT' with unique 
index 'DOCENT_DEF'.' 

  Rasa   

Document DE Bug 13567 There is possibility to open multiple instances of the same entity from 
Document/Entities Tab 

  Adas   

Document DE Bug 13569 Opening entity from Document/Entities Tab causes memory leak (EntityParam 
isn't destroyed) 

  Adas   

Document DE Bug 13629 1.Open a new document DE. Go to View> sale as template. Document 
template is opening.Go another time to view save as template. Can open a lot 
of new documents templates forms. 

  Dalia   

Document DE Bug 13650 Can create document without description.   Rasa   

Document DE Bug 13721 Document DE Template field does not retrieves components of type 'Document 
Template' 

  Abe   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document DE Bug 13803 Create new Profile, click on Tree button, have got 'Error reading 
treeAssignment.Anchors: Property does not exist'. 

  Rasa   

Document DE Bug 14122 Go to PMWIN document listing > select a document and click Copy > 
document profile window opens. Fill all the fields with the data related to DOCS 
Open integration > select Version Control checkbox > click Open Document. 

  Arunas   

Document DE Feature 11599 Allow documents to be opened as Read Only   Tom   

Document DE Feature 12003 Add 'Security button' to Doc Profile window (bellow 'Issues' button) (NTFS 
integration requirement) 

  Tom   

Document DE Info 13282 When drag image document with file name having more than 81 symbols, then 
after clicking Open Document, I get an error 'C:\101\CAT-1\... is not 
recognized' and opens empty Image Viewer screen. The same with Tiff Viewer 

  Rasa   

Document DE Info 13496 Generating document problem Seale Jason 24583 

Document DE Info 13558 In Profile DE, Type field Description is not refreshed when delete Type.   Rasa   

Document DE Info 13725 Message "Cannot Open File" is displayed when Document Profiel is opened   Abe 139-764 

Document DE Update 12481 PP location change due to PCDOCS   Darius K   

Document DE Update 13385 Changes in decedit.pas regarding access violations   Erikas   

Document DE Update 13723 If file is not found, open Document DE as read Only   TF   

Document Listing Bug 10133 Drive mappings. Tiff and Image viewers do not open document by using 
mapped drive, if document is created with long file name in PM. 

  Rasa; 
Daiva 

  

Document Listing Bug 10149 The User does not have drive mapped to source computer. When opening 
document profile, the Versions, Groupware buttons are disabled. But from 
document listing is active Version Listing and Groupware right click menu 
items. 

  Daiva; 
Rasa 

  

Document Listing Bug 11965 When hit Print Preview in Document listing, nothing happens.   Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Document Listing Bug 13232 Access violation error reported by James H. Seale James H. 
Seale 

Ken; Mike 
G 

23723 

Document Listing Bug 13316 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Document Listing Info 14441 WordPerfect docs are no longer opening using word XP, but only if you try to 
open them from the listing. 

Fuller, Johnson 
& Farrel 

Mike G 25995, 
Feedback 

Document Listing Update 11893 Update Multiselected documents Delete action   Tom   

Document Listing Update 13346 Cast filter tree item data to Integer where needed, eg.   Arturas   

Document 
Settings 

Bug 12327 Unable to Open Imageview or Tiffview in Admin>Document 
settings>Application. Inabiility to open Non-supported Applications to correct 
any configuration problems. 

  Ken   

Document 
Settings 

Bug 12358 Open Word processor that is no longer supported ( wp7) You get the message 
alright. But then an access Violation 

  Ken   

Document 
Settings 

Bug 12754 Document Settings - Options tab: Document Path problem   Tom   

Document 
Template 

Bug 11695 Open document profile > Main Menu View > Save As Template > template DE 
window opens. Select Assemble document with Practice Manager radio button 
> select Choose from Global Assignment > get an error: 

  Arunas   

Documentation/M
anuals/Help 

Bug 10430 TO section 4.4. Client Installation .... Open and run UP001.SQL query. This will 
populate database with all updates and fixes required for current build. 

  Donatas   

Documentation/M
anuals/Help 

Bug 10434 TO section 5.5. Conversion Considerations ..... Prior doing any upgrades 
please back up you database you will try to upgrade. 

  Donatas   

Documentation/M
anuals/Help 

Bug 10439 TO section 5.5. Conversion Considerations should be updated with warning 
regarding sequence of scripts; also it should say that mentioned scripts are 
used only for upgrade from 'major' versions, otherwise refer to corresponding 
upg_prep folder 

  Donatas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Documentation/M
anuals/Help 

Update 10373 There are some differences with PM 8.0 versions in some documents. See 
comments. 

  Arunas   

Documentation/M
anuals/Help 

Update 10815 Update GA turnover document with the information related to 10801, 10810, 
10812. 

  Tom   

Documentation/M
anuals/Help 

Update 11331 Update TO: Update MS SQL 7 requerements to be SP4 - version 7.00.1063 //- 
7.00.1063 Database Components SP4 

  Saulius   

Documentation/M
anuals/Help 

Update 11726 Turnover Document Update   Tom   

Documentation/M
anuals/Help 

Update 12024 Update turnover - include information that PM client must be installed in order 
to run Practice Manager. 

  Ken; 
Arunas 

  

Documentation/M
anuals/Help 

Update 12263 Update TO with following info   Darius K   

Documentation/M
anuals/Help 

Update 12267 Update TO with following info   Darius K   

Encryption Update 12299 Move the registration files to a <pmroot>\reg\ subfolder. This way, read/write 
rights only need to be on that folder and not <pmroot>. Update the Login Code 
to support this 

  Tom   

Entity Assign Bug 11565 Duplicate entity records shown in Entity Assign listing Wilkes & 
McHugh - 0244 

Donatas   

Entity Assign Bug 12925 User receives " is not a valid date and time" error, when trying to save entity, 
which DOB has been deleted. 

Bacon & 
Wilson - 0201 

Mike G 23478 

Entity Assign Bug 13441 Assign Wizard does not release used resources (SQLSettings, SoftFilter)   Adas   

Entity Assign Update 13347 Cast filter tree item data to Integer where needed, eg.   Arturas   

Entity DE Bug 11713 Entity Tree View filters defaults problem   Tom   

Entity DE Bug 12128 New Entity - Individual/Client - Other Details - Client Settings does not appear Patten - 0206 Ken   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity DE Bug 12139 Change Staff Information security should not have an impact on Code field in 
Other Details tab 

  Tom   

Entity DE Bug 12152 Problem with entity info screen opening performance Glasser & 
Glasser - 0185 

Gedas   

Entity DE Bug 12322 Problem opening Entity Record from within a matter and from the global 
listing.: If SSN is null, receive a message that an entity with this SSN already 
exists and you cannot get to another tab or close the record. 

Glasser & 
Glasser - 0185 

Ken   

Entity DE Bug 12374 It is impossible to create matter-specific relationship to an entity.   Sigita   

Entity DE Bug 12514 After upgrade from PM80 to PM87341, bar number has no jurisdiction, which 
was assigned in PM80. 

  Rasa   

Entity DE Bug 12600 Speed dial number not displayed, when opening Entity DE   Mike G   

Entity DE Bug 12960 Open Entity DE, go to Related Tree, uncheck 'Matter Specific' checkbox - get 
error message: 

  Mike G   

Entity DE Bug 13230 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Entity DE Bug 13315 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Entity DE Bug 13320 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Entity DE Bug 13327 Checking for duplicate entity names was incorrect, if individual entity has 
empty first name 

  Adas   

Entity DE Bug 13432 Entity DE, Mailing List - EntParam has not been released   Adas   

Entity DE Bug 13435 Related Tree - Items have not been released when closing Tree   Adas   

Entity DE Bug 13437 Related Tree does not release temporary list, used for History View   Adas   

Entity DE Bug 13438 Related Tree does not release loaded bitmaps   Adas   



Printed: 03/21/2003  Last Updated: 03/21/2003 
 RealLegal, LLC Confidential and Proprietary Information 
 Practice Manager - Pumasillo Project � Project Summary Specification v2.0 

C:\Documents and Settings\TFOLEY\My Documents\rl.stuff\dev\pm_core\andes\pm88.Pumasillo\specs\pumasillo_pss_v0200.doc  
Copyright © 1992-2003 RealLegal, LLC, Rev. No. 10 Scope – Exclusions l 61 

Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity DE Bug 13439 Related Tree does not release resources, used for opening and creating new 
notes and timeslips 

  Adas   

Entity DE Bug 13462 Open all the listings. Open any matter > go to entities tab > open any assigned 
entity that has nothing in Address Description field > enter anything in address 
field (leave Address Description field empty). 

  Arunas   

Entity DE Bug 13489 Access Violation when close PM. This happens, when open the same entity de 
form from diffrent PM places. 

  Rasa   

Entity DE Bug 13490 PM screens become mixed.   Rasa   

Entity DE Bug 13602 It is possible to create entity with only Type assigned   Donatas   

Entity DE Bug 13624 Create new individual entity > select Entity Type and enter Last Name only 
(eg.'Test01') > Save. Create one more entity > again select Entity Type and 
enter Last Name = 'Test01'. The system presents a message that entity 
'Test01' already exists > click OK 

  Arunas   

Entity DE Bug 13657 Access Violation in Entity DE Related Tree   Donatas   

Entity DE Bug 13662 In Entities: Related Tree get an error when filtering by Status.   Sigita   

Entity DE Update 11026 Display a warning from the Entity Role DE and Entity Type DE if the 
description changes and that Role or Type is used in a Document Assembly 
Component. 

  Donatas   

Entity DE Update 13838 Move the "Require Bar Number" field and button to the General tab and make 
always visible 

  TF   

Entity DE Update 13888 Add new functional security "Allow General Bar Numbers". By default, it should 
not be assigned to any roles 

  TF   

Entity Listing Bug 10135 Create entity auxiliary (in FD) with required fields. Assign this form to entity. 
Open auxiliary from right click menu, not enter anything and hit Save. Have got 
warning message (that's ok) and click Cancel button, the auxiliary form not 
closed. 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Entity Listing Bug 10187 Entities listing. I filter by multiple matters. If my entity is assigned to 3 matters, 
it is displayed in the listing 3 times. 

  Daiva   

Entity Listing Bug 11517 Prolem with typesearch when creating new entity.   Vaidas   

Entity Listing Bug 12286 DOD field is not showing up in the Entity list Glasser & 
Glasser - 0185 

  23106 

Entity Listing Update 11861 Update Multiselected entities Delete action like it works in Documents and 
Workflow listings. 

  Tom; 
Arunas 

  

Entity Listing Update 13345 Cast filter tree item data to Integer where needed, eg.   Arturas   

Entity Merge Bug 12550 Create two entities: entity1( fill just last name field) , entity2 (fill all General tab 
fields, and enter primary address with phones. Merge entities: select target 
entity1 and source entity2. 

  Dalia   

Entity Merge Bug 13404 Tools > Entity Merge opens multiple Entity Merge Utility screens   Rimas   

Entity Merge Bug 13537 EntityMerge doesn't destroy QueryDelInfo object   Adas   

Entity Settings Update 11176 Update Entity Type and Entity Role screens in Entity Settings so that when 
warning is being shown about changed Entity Type or Entity Role description 
corresponding change set needs to be generated for utility described in #9941. 

  Darius K   

Entity Settings Update 12893 Create default Address Description and use to populate Addresses where the 
Description is null 

  Tom   

Faxing Bug 12957 Go to Document listing > select any document > Right click mouse > select 
Fax. Login to RightFax window appears. In Username field I see 
"CBoxUserName" value (Password field is empty). Username field should be 
empty also. 

Domengeaux Arunas 23560 

Faxing Update 12987 RightFax Fax information window > click Add Recipient > Select a recipient 
window appears. I cannot enter anything in Available Recipients field. 

  Arunas   

Filter Bug 11574 In any listing hit on 'Retrieve Filter or Query' screen. Filter by any column by 
not existing value. Filter listing screen is empty, but buttons 'Change name', 
'Apply' or 'Delete' are active. 

  Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Filter Bug 11629 Error message "Invalid floating point operation" when retrieving filter.   Vaidas   

Filter Bug 13471 Filter forms do not free internal settings   Arturas   

Filter Update 11870 Change Filter modules according Arturas suggestions to avoid possible 
memory leaks. Check TEditLookupGroup objects in Filter units are there all of 
these freed correctly. 

  Saulius   

Filter Update 13329 Update filter tree construction/applying procedures to use Integer datatype 
instead of TPInteger datatype for IDs store 

  Arturas   

General Bug 13321 Access Violation errors reported by Bacon & Wilson Bacon & 
Wilson - 0201 

Ken; Mike 
G 

24025 

Groupware DE Bug 10506 E-Mail System = MS Outlook. Drag and drop email with attachment from 
outlook to PMWIN. After try to edit or view this mail, have got an error 'Invalid 
variant type conversion.' 

  Rasa   

Groupware DE Update 12911 Some times when was opening groupware item(mail engine - Groupwise) 
message "Update access is denied to current user" popups 

  Saulius   

Groupware 
Listing 

Bug 11174 Problem when changing columns order.       

Groupware 
Listing 

Update 13349 Cast filter tree item data to Integer where needed, eg.   Arturas   

Groupware 
Listing Hot Filter 

Bug 13448 Groupware hotfilter window not freeing TCommonInLastDays objects   Saulius   

Groupware 
Template 

Bug 10193 Groupware Settings > Groupware Template tab: add column Public to listing, 
sort by it, type search it by pressing e.g.'s', so that popped combo box would 
be empty, go to other tab - get access violation 

  Donatas   

Guideline Info 12216 Behavior of DE forms when closing   Tom   

Guideline Update 11356 Printing of individual forms is available except OCX screens.       
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Help Feature 13700 Add new feedback form to error message and help menu (see the referenced 
e-mail for details). Related to 13493 

  TF   

Help Feature 13701 Addition for the Help Menu Lewis Kinard TF   

Help Info 13703 Help>About>details results in message Your Installation is missing required 
file(s). Try reinstalling the package 

Ice Miller Ken   

Help Update 11114 Change the Details window to be a vertically scrolled listing instead of a 
horizontally scrolled listing 

  Tom   

Help Update 13922 Change the default e-mail address (hard coded and in PMFeedback.cfg.xml) 
for the TO field to "support@reallegal.com" 

  TF   

Help Update 14756 Do not start Outlook every time when Feedback form Send button is pressed.   Ken   

Help Update 14757 I noticed that the feedback form remains open while it is try to open the e-mail 
message. This actually allows the user to click Send again which causes 
another e-mail thread to fire and "Choose Profile" gets buried under the second 
feedback form 

  TF   

Hot Docs 
Integration 

Bug 12199 HotDocs Freezing Ward Hadaway 
- 0250 

  22945 

Imageview Update 13543 the Image Viewer software does not properly save it’s settings. Amfam Ken   

Install/ Upgrade Bug 10109 PM Server install does not find any default path for Practice Manager database 
location (the path field is blank). MSSQL server type = named instance. 

  Arunas   

Install/ Upgrade Bug 10402 When running up86to87.sql or up87_009.sql, some error messages appear.   Arunas   

Install/ Upgrade Bug 10836 When upgrading PM Server from 8.0.75.1 to 8.7.24.6 using 8.7.24.6A network 
server upgrade program, answers.ini file is missing in PMROOT directory. 

  Arunas   

Install/ Upgrade Bug 11348 Install PM Client on Win98. In autoexec.bat not inserted <PMRoot> path.   Rasa   

Install/ Upgrade Bug 12030 PMWin installation is incorrectly repaired   Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Install/ Upgrade Bug 12123 When installing (or upgrading) MDAC on one workstation, mdac_typ.exe file is 
deleted in <PMROOT>/Client_ins (or Client_upg - if MDAC was upgraded) 
directory. 

Glasser & 
Glasser - 0185 

Ken; 
Arunas 

23008 

Install/ Upgrade Bug 13659 New Client Install/Upgrade - detect if 
<pmroot>\pmpurger_ins\PM_Purger_client_v010.exe exists. If yes, include it in 
the client install/upgrade. 

  TF   

Install/ Upgrade Info 14084 Manual install mode is broken   Gedas   

Install/ Upgrade Update 10270 These files are to be included in the file set. They need to be in the Upgrade 
CD folder. 

  Tom   

Install/ Upgrade Update 11350 Register utility implemented in 9941 in client install according to Airenas 
comments. 

  Daiva   

Install/ Upgrade Update 11822 Update PMWIN client installs to run PMWIN after installation with special 
command line switch (see 11819) 

  Darius K   

Install/ Upgrade Update 12035 Verify that all custom PMWin error messages exist in sysmessages table 
before performing an upgrade 

  Tom   

Install/ Upgrade Update 12428 Updates to the Upgrade Program: Remove the screen that gives the user the 
option of running the utilities from inside the Upgrade program. 

  Tom   

Install/ Upgrade Update 12501 Include MSWDAFIX.EXE, MSWDAFIX.txt and PMTemplate.txt to installs and 
upgrades 

  Tom   

Install/ Upgrade Update 12849 Modify Client Install/Upgrade logic to only use the answers.ini file for the user 
path OR the selected PM folder 

  Tom   

Install/ Upgrade Update 12853 Remove workstation file location from path. The only path needed is the User 
Path to PM (svUserDir) 

  Tom   

Install/ Upgrade Update 13717 Include law_cim.dll in installs   DK   

Install/ Upgrade Update 13910 Is word 2000 folder really necessary on the release site?   Ken   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Install/ Upgrade Update 13962 I install new copy of PMWin on my machine. When I attempt to connect get an 
error message, attached. 

  Andrej   

Install/ Upgrade Update 14411 Include the new TiffView AIPE in the client install   TF   

Install/ Upgrade Update 14637 Include WFItemsCancelingInClosedMatters.exe utility into installs/ upgrades 
for 8.7.40.4 

  TF   

Issue Listing Bug 13618 When closing Issues listing all opened issues are closed   Adas   

Legal Vision 
Integration 

Bug 11219 Can save the record in Pay to field if using mouse, go to any other field. If user 
use buttons 'Tab' or 'Enter' message 'RECORD NOT FOUND' appears. 

  Laura; 
Dalia 

  

Legal Vision 
Integration 

Bug 11281 In Legal Vision create an employer and after synchronize it to PmWin- after try 
to open this entity DE- have got an errors- 'Underfined Security','Cannot focus 
a disabled or invisible window'. 

  Dalia   

Legal Vision 
Integration 

Bug 11958 Open Timeslip listing, login to Legal vision. Have got an error: '10/17/2002' if is 
selected Date/Time formats 'DD/MM/YY' or 'YY/MM/DD' in System settings 

  Dalia   

Legal Vision 
Integration 

Bug 12588 Replaced 'automation error' with more verbal error message. Also error does 
not require to restart PM now. 

  Dalia   

Legal Vision 
Integration 

Bug 12747 Try to create timeslip template. Enter template code and template description. 
Try to save template. Hit on button 'Save'. Have got an error: 
FilterQueryMatter: Field 'MATTERNUMBER' not found. 

  Dalia   

Legal Vision 
Integration 

Bug 12889 Matter Rates Listing -> Enter Rate -> Refresh ->invalid date 'xx/xx/xxxx' . (This 
error can get is in PC settings date format is ex. dd-mm-yy ) 

  Dalia   

Legal Vision 
Integration 

Info 12649 Cannot post Timeslip to LV- have got automation error ( error in LV11). It is 
working the same as in 8.0 after Vygintas fixes. 

  Dalia   

Legal Vision 
Integration 

Info 12651 Cannot post matter rates . Error in LV11   Dalia   

Login Bug 13737 Login screen->change site (Note: missing a "you" in the sentence "Choose an 
Active Site from the drop-down list. The Active Site is the site you want to work 
with." 

  DK   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Login Update 10740 PM allows for both NT Authentication and SQL authentication while PM 
Remote does not. This is a big issue for this client as they only use NT 
Authentication for security purposes. 

AMFAM - 0100 Ken 0100-2529 

Login Update 11885 Update dialog 'Warning, YOUR connection to database dropped' to have 
Details button. Details button should display more information about occured 
exception 

  Tom   

Mail Merge Bug 12424 When merge Mail Merge Template and this template has the fields form Entity 
Type group. Have got the errors 'Merge Error. Possible problem: field ... not 
found' (DB=Glasser872; Mail Merge Template='_rm_word97_mail merge 
template') 

  Rasa   

Mail Merge Bug 12436 Merge Address Template. There are retrieved some fields with incorrect info. 
Example: in Addr_BarNumber field retrieved SiteCode, Addr_DOB is empty, in 
Addr_DOD-> e-mail… 

  Rasa   

Matter DE Bug 11728 Try filter entity listing by to roles in Matter DE. Role ComboBox in quick filter is 
not respected. Also we have two role's fields in Filter DE>Entity listing>Matter 
DE: combo box and cowboy hat 

  Dalia   

Matter DE Bug 11855 Open matter Listing. Create a new matter. Fill general tab, go to entities tab. 
Leave matter screen opened. Open matter listing using menu icon. Matter 
listing screen's size is bad. 

  Dalia   

Matter DE Bug 13036 A comment in litigation matter disappears.   Sigita   

Matter DE Bug 13236 Access violations reported by Patten Patten - 0206 Ken; Mike 
G 

24414 

Matter DE Bug 13255 Access violation reported by Shriner Shriners - 0209 Ken; Mike 
G 

  

Matter DE Bug 13395 Memory leak in Saga Overview, Plaintiff and Defendant screens. TreeView 
doesn't free items when security is being applied 

  Arturas   

Matter DE Bug 13397 Invoke atached to tabs child forms FormClose method   Saulius   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter DE Bug 13578 1.Open Matter DE>General tab. 2. Open Matter settings using button near 
Jurisdiction field. 3. Open New jurisdiction field.4.Open Entity listing using 
button near court field.4. Try create a new entity from Entity listing >View 
menu. 

  Dalia   

Matter DE Info 11854 New matter is not saved.   Dalia   

Matter DE Update 11709 Add new checkbox 'Matter Client' in Entity DE>Matter DE.   Dalia   

Matter DE Update 12276 Review logic of hard-coded matter intake sheet   Tom   

Matter Listing Bug 10174 Error message "The parameter is incorrect"   Vaidas   

Matter Listing Bug 11562 In Matter listing select multiple matters, go to File, Delete - nothing happens. 
Implement delete action as it works for Documents and Workflow listings. 

  Arunas   

Matter Listing Bug 13317 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 
0244; Shriners 
- 0209 

Ken; Mike 
G 

23208;24483 

Matter Listing Bug 13419 Access Violation in Matter Listing   Vaidas   

Matter Listing Bug 13443 MatterListing and matter template listing code: In both listings OnQuerySave 
methods use unassigned variable "lp" that might cause AV 

  Arturas   

Matter Listing Bug 13535 MatterFilter doesn't destroy OrgSet, FilterOpened, FilterClosed objects.   Adas   

Matter Listing Bug 13652 Access Violation errors reported by Bacon & Wilson Bacon & 
Wilson 

Mike G, 
Ken F 

24025 

Matter Listing Update 13344 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter Listing Update 13919 Add Jurisdiction Code as an available column heading to the Matter Listings AmFam Cynthia   

Matter:Annotation
s 

Bug 10239 Drive mappings. Can not open image viewer (tiff viewer) from Matter: 
Annotation tab. 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter:Annotation
s 

Bug 10281 If in Index lookup exist two annotations with the same description, annotation 
listing not refreshed. 

  Erikas; 
Rasa 

  

Matter:Document
s 

Update 13353 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter:Entities Bug 11341 There is the same entity assigned with different roles to the matter in Matter-
Entity listing (e.g. with 'Other' and 'Adjuster' roles). For example: 1) open entity 
with role='Other' and change role to 'Adjuster'. Go to another tab. Have got an 
error: 

  Rasa   

Matter:Entities Bug 11549 In System Settings check 'Disable Entity Assignment Wizard'. When create 
new entity from matter-entity listing and select Party Type, on Save have got 
message 'The same Entity cannot be a ... twice in one Matter'. 

  Rasa   

Matter:Entities Bug 11878 Entity Role, Role Details, and Matter Side don't respect Site Security of the 
Matter (other fields do). 

  Tom   

Matter:Entities Bug 13314 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Matter:Entities Bug 13450 Access volation got when select entity in Matter:Entity listing.   Rasa   

Matter:Entities Update 13352 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter:Groupwar
e 

Update 13356 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter:Issues Bug 11936 Access Violation when tabbing to issues.Document listing in a Matter Issue DE   Ken   

Matter:Issues Bug 13616 There is a possibility to open multiple instances of the same Issue from 
Matter/Issues listing. 

  Adas   

Matter:Notes Update 11071 Change Matter Note Listing Hot Filter Type to be look-up on all combinations 
(change "Type" to be "Notes to Show") 

  Tom   

Matter:Notes Update 11073 Change Matter Note Listing Filter "Show Notes For" to be look-up on all 
combinations (change "Show Notes For" to be "Notes to Show") 

  Tom; 
Donatas 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter:Notes Update 13355 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter:Overview:
Court 

Bug 10491 Problems with Role field in Court DE window Judge/Arbitrator Details tab. See 
comments. 

  Arunas   

Matter:Plaintiff Bug 10531 1) International format is checked. Go to Litigation Matter: Plaintiff: Plaintiff tab 
and select party = person, the SSN field has mask. The same in Litigation 
Matter: Defendant: Defendant tab. 

  Rasa   

Matter:Plaintiff Bug 13715 Incorrect calculations in Special Damages Screen   Abe   

Matter:Plaintiff Bug 13826 Incorrect calculations in Special Damages Screen   Abe   

Matter:Plaintiff:M
edicals 

Bug 10157 Create a new record. Remove Provider column from upper listing > hit New in 
Treatments tab > get an error message: "qMedical: Field 'ENTITYNAME' not 
found." 

  Arunas   

Matter:Timeslip Update 13354 Cast filter tree item data to Integer where needed, eg.   Arturas   

Matter:Tree View Bug 11720 There is Full Text Search integration installed on computer. When apply filter 
with text search criterias in tree view, have got an error. 

  Rasa   

Matter:Tree View Bug 11960 Cannot see documents in tree view   Vaidas   

Matter:Tree View Bug 12977 Get an error in Matter:Tree View when Entity:Related Tree is opened.   Mike G   

Matter:Tree View Bug 13515 Error in matter treeview when filtering by Law Category   Aurelija   

Matter:Tree View Bug 13637 PM screens become mixed.   Rasa   

Matter:Tree View Update 11700 Matter DE Tree View filters - updated   Vaidas   

Matter:Workflow Bug 11858 Cannot start workflow plan.   Vaidas   

Matter:Workflow Bug 12373 In the plan view of matters we have a problem with the way the plans are 
ordered. 

Glasser & 
Glasser - 0185 

Ken 23244 

Matter:Workflow Bug 12458 If there is a timeout when starting plan, next time when PMWin is started, plan 
has items, but it's status is still 'not started' 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Matter:Workflow Bug 13318 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Matter:Workflow Feature 14397 Create utility that would complete all plans and mark unscheduled and 
uncompleted items as cancelled for matters that are closed 

  Ricky   

Matter:Workflow Update 12132 Improvements for Workflow Speed   Tom   

Matter:Workflow Update 13357 Cast filter tree item data to Integer where needed, eg.   Arturas   

Note DE Bug 10268 Note saves without Confirmation message.   Vaidas   

Note DE Bug 11065 Open Phone Note - Get error "Invalid variant type conversion" on Close. Try to 
Save, get error. Then close works. Does not happen on all notes. May be a 
database error, though this was a PM86.34.X database upgraded to 
PM87.24.6A. Test on WinXP 

  Tom; 
Donatas 

  

Note DE Bug 11441 Able to unassign Creator and Author.   Vaidas   

Note DE Bug 11683 Open Phone call de>Details tab>Entity listing. Assign all column in entity 
listing. Hit on View>Entity mass mail merge. Have got an error: 'Line 1: 
Incorrect syntax near ')'' 

  Dalia   

Note DE Bug 11688 In Phone Call DE >Relate to entities tab change column caption ID to Code.   Dalia   

Note DE Bug 11902 Error message when saving phone call   Vaidas   

Note DE Bug 12456 8.0 Allowed tabbing within a note. 8.7 does not Shriners - 0209 Ricky   

Note DE Bug 13319 Access violations reported by Wilkes&McHugh Wilkes & 
McHugh - 0244 

Ken; Mike 
G 

23208 

Note DE Bug 13572 Open Matter DE> Note listing. Select note that is assigned to a lot of Matters, 
Entities and Issues. Try open Note de> Relate to issues tab. Have got timeout 
error. 

  Dalia   

Note DE Bug 13620 Memory Leak: Note DE, Other Party Cowboy hat button doesn't destroy 
opened Entity listing 

  Adas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Note DE Bug 13635 Open a new note DE. Go to View Menu >Retrieve Templates tab. Select Note 
template with filled only Note type field. Try to same just created note. Have 
got message: Undefined Description. Fill description field. 

  Dalia   

Note DE Update 11438 Change message which appears when trying to save Note without assigning 
additional entities to Note. 

  Donatas   

Note Listing Bug 11062 Preview Note does not work correct.   Vaidas   

Note Listing Bug 11094 Tab order is working incorrect in Note listing: after activating button 'Close' is 
activated button 'New Phone Call'. correct tab order is New > Open > New 
Phone Call > Close 

  Dalia   

Note Listing Bug 11505 When creating new note item, the site is not the same as current site.   Rasa   

Note Listing Bug 11649 Problem with filter.   Vaidas   

Note Listing Bug 11667 Create some notes. After login to PM as SA and delete creator of these notes. 
All created notes were deleted (even if author of these notes was not this 
deleted user) 

  Dalia   

Note Listing Bug 11797 Problem with matter security in Note Listing   Vaidas   

Note Listing Bug 13952 Matter No. does not respect Use ClientNumber.MatterNumber from System 
Settings 

  TF   

Note Listing Feature 11061 See Comments Saga #632 Abe (632)   

Note Listing Update 11063 The Preview item should not appear in Note listing if the user does not have 
Edit security function (see PCR 9589). 

  Tom   

Note Listing Update 11069 Change Global Note Listing Filter "Show Notes For" to be look-up on all 
combinations (change "Show Notes For" to be "Notes to Show") 

  Tom; 
Donatas 

  

Note Listing Update 12926 Add the Matter column back in for the Notes Listing   Tom   

Note Listing Update 13351 Cast filter tree item data to Integer where needed, eg.   Arturas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Note Listing Hot 
Filter 

Bug 13531 NoteFilter form doesn't destroy FilterCreatedInLastDays object   Adas   

Note Listing Hot 
Filter 

Update 11067 Change Global Note Listing Hot Filter Type to be look-up on all combinations 
(change "Type" to be "Notes to Show") 

  Tom; 
Donatas 

  

Palm Integration Bug 10519 Entity synchronization - <Esc> should not close Entity Select Screen.   Daiva   

Palm Integration Update 11929 Type filter in Edit > Preferences > Synchronization Settings > Entity Types to 
Synchronize assignment screen is of old type 

  Donatas   

Palm Integration Update 11957 Change User Preferences->Synchronization Settings-> Synchronize Entity 
Types screen 

  Darius K   

Phone Call DE Bug 12133 Record in NTENTAS for 'Other Party' of phone call is created only when 
creating a new phone call. 

  Donatas   

Phone Call DE Bug 12148 Clicking No on Save Changes? Message saves this Phone Call.   Mike G   

Phone Call DE Bug 12149 Other Party phone numbers would not be populated, if user clicks on Relate to 
Matters tab returns to Details tab, and chooses Other Party 

  Mike G   

Printing Bug 11515 Sometimes in Report Preview screen Close buttons is disable (On Win98 it is 
almost always disable, on Win2K just sometimes) 

  Rasa   

Printing Bug 11640 Report is not corect when printing timeslips   Vaidas   

Printing Bug 12495 Cannot print Quick Report, which was saved to file: any listing ->Printer-
>Preview->Open Report from File->Load Report screen->Open->click Print 
Report and nothing happens 

  Mike G   

Printing Bug 12497 Print Preview screen gets cut-off, when using 800x600. Cannot see "Save 
report to File" and "Close Report" buttons 

  Mike G   

Printing Bug 12950 When printing from the workflow listing and then click print report and when the 
printer box pops up choose 2 copies, it only ever prints one. You can print 2 
copies from preview report 

Glasser & 
Glasser - 0185 

Mike G 23665 
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Printing Bug 13271 Go to entity listing > click Printer icon > go to Customize tab > click [>>] button 
(add all available columns to print report) > click Preview > printer window 
closes. No report preview window appears. 

  Arunas   

Printing Bug 13280 Go to Note Listing and add Matter Name column. Select Print Note Contents, 
have got message 'The column prefix 'NOTE' does not match with a table 
name or alias name used in the query' 

  Rasa   

Printing Bug 13440 Print Preview does not release loaded bitmaps   Adas   

Query Bug 11344 Problem with query in Timeslips listing       

Related Entities Bug 10255 In Related Entities tab listing or Related Entities DE listing select Entity-
Specific only and type search by some column, then switch to Matter-Specific 
only - type filter popup is hidden, filter is not removed and listing remains 
filtered 

  Donatas   

Related Entities Bug 13431 Related Entities Listing - Notifier has not been destroyed   Adas   

Remote Bug 13974 Downloading with Remote results in dropped connection error   Ken   

Remote Update 11377 Launch PMRemote > select Download Entire Address Book along with 
Selected Matters > assign any matter to download > click Download Now 
(there are 2233 entities in PM). Download completes successfully. But after it I 
cannot login to Remote PMWIN. 

  Arunas   

Remote Update 13828 Modify PMRemote to detect what kind of authentication is used on the local 
database and connect accordingly. Only convert the value in System Settings 
to "Prompt for All" if the Firm DB = NT Authentication and the Remote DB = 
SQL Authentication 

  TF   

Remote Update 13860 When "Update Now" is selected, close the PMRemote Download window   TF   

Remote Update 13868 Check to make sure the target database is the correct one when you click 
Download Now. If it does not match the source database, displays the same 
error as if you picked the wrong one is selected in the Target field 

  TF   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Remote Update 13999 Change the database link message to read as follows "In order to download or 
upload with PMRemote, the user [username] must be a member of the 
sysadmin server role on the local SQL Server." 

  TF   

Security Settings Update 11121 Restore 'Show All Paths' functionality   Donatas   

Security Settings Update 13906 Add security function 'Report Errors and Send Feedback' for PCR 13700   TF   

Site Settings Bug 13739 tab order is incorrect in Site settings->tab Drive Mappings-> Drive Mapping DE   DK   

Source Code Bug 11708 Problems with PM on Windows 98 SE. When working with PM for a while, 
system runs out of system memory (there are ~500Mb free space on system 
disk and my computer has 256Mb of RAM). 

  Arunas   

Source Code Bug 13234 Access Violation errors reported by Bacon & Wilson Bacon & 
Wilson - 0201 

Ken; Mike 
G 

24025 

Source Code Bug 13311 Access violation error reported by James H. Seale James H. 
Seale 

Ken; Mike 
G 

24583;23723
;24426 

Source Code Bug 13364 Fix object TChangeTrack constructor in ChangeTrack.pas unit   Arturas   

Source Code Bug 13539 Same matters, entities, documents, timeslips, notes and issues can be opened 
multiple times from RelatedTree. 

  Adas   

Source Code Bug 13600 Open Matter Listing, Document Listing. Create New Document Profile, enter 
description. Try to change active site. Have got AV. 

  Aurelija   

Source Code Bug 13622 "Change Site" can leave some windows opened. If opened window reports 
error (for ex. Description is empty) and refuses to close - active site changes 
but window stays opened. 

  Adas   

Source Code Feature 13288 Add WaitForSingleObject(mx, 1); // request ownership of the mutex after mx := 
CreateMutex(nil, True, MutexName);. This mus be done to PMWIN.dpr file. 

  Arturas   

Source Code Update 11931 Review GetMatterSecurityWhere function in GlobalUtilities   Saulius   

Source Code Update 13292 Memory leak in TADOFilterQueryPM: the bookmark is not freed when it points 
to the record that doesn't exist in new dataset after quick filtering. 

  Arturas   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Source Code Update 13493 Add three publish points   Saulius   

Source Code Update 13672 Make date separator to be saved as UPPERCASE, because DATEFORMAT 
are saved as uppercase and in this case current dateseparator are not found in 
in dateformat 

  Saulius   

Spellchecker Bug 13362 SpellCheck of note gives error 'RPC server is unavailable'   Ken; Mike 
G 

24625 

Spellchecker Bug 13393 Spellchecker in Document Version - Description.   Daiva   

Spellchecker Bug 13511 Open PMWin, check correct text for spelling errors anywhere (no "Spelling" 
window with suggestions). Close PMWin. WINWORD.EXE remains in Task 
Manager 

  Rimas   

Spellchecker Bug 13574 Open any document profile. Create a new document version. Use Spellchecker 
for document version description. After Document is opening. Close Pmwin. 
Open that new document. Have got Word message : 

  Dalia   

System Settings Bug 10101 Go to System Settings>Options tab, type search column Value Type - get error 
'Invalid column name 'VALUETYPE'' 

  Donatas   

System Settings Bug 10102 Go to System Settings>Options tab, go to More Columns, remove all columns, 
except Value, press OK - get error message 'FilterQueryPMOptions: Field 
'TYPE' not fout found' 

  Donatas   

System Settings Bug 10607 Acces violation after copying settings.   Vaidas   

System Settings Bug 13611 Date Formatter screen: Date Example and Time Example fields are empty.   Mike G   

System Settings Update 11034 Change field labeling and order Drive Mapping DE form to be a little more 
logical. 

  Donatas   

System Settings Update 13664 Review and update Date Separator field functionality   DK   

Timeslip DE Update 10937 Change parameters that Practice Manager will support for billing export 
modules. 

  Donatas   

Timeslip Listing Bug 10923 Export module problem - see comments.   Darius K   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Timeslip Listing Bug 11250 Eight of the display fields for the Timeslip listing have spaces before them, 
which is messing up the sort order. Please remove the spaces. 

  Tom   

Timeslip Listing Bug 11507 Access violation when opening query.   Vaidas   

Timeslip Listing Bug 11635 Search by any column in timeslip listing. Open Timeslip Archive Listing. Search 
screen still active. Now drag and drop any column. Search screen is active, but 
is not moved with column. The same can get in Timeslip listing too. 

  Dalia   

Timeslip Listing Bug 11653 Select 'None' in Billing Program field> General tab>Timeslip settings. Rerun 
PMWIN. Open Timeslip listing. Hit on Export using right click. Have got an 
error: Could not launch export application. 

  Dalia   

Timeslip Listing Bug 13055 Publish Point PPGUID_TimeslipListingQueryAdapter is not being handled 
properly 

  Edmunda
s 

  

Timeslip Listing Update 13348 Cast filter tree item data to Integer where needed, eg.   Arturas   

Timeslip Listing Update 13779 User opens timeslip tab from within a matter. Recieves error message 'Either 
BOF or EOF is true or the current record has been deleted. Requested 
operation requires a current record.' 

NFI Industries 
0262 

ken 25142 

Timeslip Listing 
Hot Filter 

Bug 13533 TimeslipFilter doesn't destroy FilterInLastDays object.   Adas   

User Preferences Bug 10126 Adapters menu is not displayed in User Preferences, though required dll's are 
registered, while in System Settings it is visible 

  Rimas; 
Donatas 

  

User Preferences Bug 12448 In some dbs under edit preferences - you cannot select the spellcheck 
application- nothing shows up. 

  Ken   

User Preferences Info 11722 Brach is expended after answer, if is checked or not checked checkbox 
'Expand workflow plan branch after answering question' in User 
Preferences>Workflow 

  Dalia   

Utility Bug 11876 In 'PM Document Template Utility' screen> Log tab move 'Status' column next 
to 'Component Description' column, then go to another tab and return to Log 
tab, have got an error 'Invalid object name 'ASM_UPDTELOG'' 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Utility Bug 11940 When run Convert Utility, the fields of Address Template component is not 
updated. 

  Rasa   

Utility Bug 11947 When you have Word XP installed on computer and run Convert Utility, then 
just the components created with Word97 and Word XP are updated. The 
components where engine=Word 2000 are not updated. 

  Rasa   

Utility Bug 12045 After upgrade from 8.0.78 to 8.7.28, Mat_CivilActNo field is not renamed to 
Mat_CaseNo. 

  Rasa   

Utility Bug 12047 After upgrade from 8.0.78 to 8.7.28, some Entity Type fields are not converted.   Rasa   

Utility Bug 12049 A component has Engine=Default (in 'Document Component Design' screen). 
Run PMTemplate utility, this component is not updated. 

  Rasa   

Utility Bug 12137 TiffView functionality is not correct Patten - 0206 Ken 23409 

Utility Bug 12466 We found problem with WordSpell.dll file. It will load only if in file attributes will 
be checked on "Archive" or in some other systems something like "Ready for 
archiving". 

  Saulius   

Utility Bug 12556 When running PMTemplate, we received timeout error   Mike G   

Utility Bug 13685 Access violation in wfstatfix.exe   TF   

Utility Feature 12426 MS Word Document Assembly Component Fix Utility   Tom   

Utility Feature 12512 While running MSWDAFIX.EXE utility if login fails (server name and/or 
database name and/or user name is incorrect), a message informing about it 
should be displayed and the process stopped. 

  Sigita   

Utility Info 11528 When I run convert.exe straightly from pmroot/Utilities folder, I get "UDL not 
found". I must copy the utility to pmroot folder to run it. 

  Daiva   

Utility Update 11606 PMTemplate utility - changing of status of Change Sets.   Tom; 
Daiva 

  

Utility Update 11880 Create Utility for deleting workflow items under unaccepted answers on 
completed plans. 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Utility Update 11882 Run a Convert Utility. When any component is updating, stop process (hit 
STOP button in PM Document Template Utility screen). After that this 
component is broken - not all fields are updated and the status of the 
component is marked as 'updated'. 

  Rasa   

Utility Update 12356 To the window for convert97 and pmtemplate, add a text note at the top of the 
window that reads as follows: 

  Tom   

Utility Update 12604 <\\Ltdevsql1\D\QA\builds\pm\pm_v87sp1\build873502\files\utilities\MSWDAFIX
1005.EXE> does not include MSWDAFIX.txt. 
<\\Ltdevsql1\D\QA\builds\pm\pm_v87sp1\build873502\files\utilities\PMTemplat
e1126.exe> does not include PMTemplate.txt 

  Tom   

Workflow 
Calendar 

Bug 10105 User without Edit Workflow security can Change Matter from the right-click 
menu. 

  Arunas   

Workflow 
Calendar 

Bug 10487 When close workflow calendar, also closed Pmwin.   Rasa   

Workflow 
Calendar 

Bug 12568 In Workflow Calendar set filter to show only Completed activities; 
Completed/Held by Event/Due date. In Workflow Calendar also appear items 
with today's Event/Due date that are Not Started and In Progress. 

  Ligita   

Workflow 
Calendar 

Bug 12574 In Workflow Calendar when filter is set to show all Cancelled Workflow 
Activities; Cancelled Items by Cancelled Date, all unscheduled activities 
appears in current day although have different Cancelled Date. 

  Ligita   

Workflow DE Bug 11410 Problem with "Show All Paths" functionality in Workflow paths.   Vaidas   

Workflow DE Bug 11513 When Upgrading From 8.0 to 8.7 plan items that have their due date linked to 
the completion of a parent wf item lose than link. 

  Ken   

Workflow DE Bug 11590 Create a plan in Workflow settings. Do not insert any question or answer to this 
plan. After open matter and add this plan. Start this plan, insert ex. 
appointment. Now insert questions and answer. Cannot edit question or 
answer. 

  Dalia   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow DE Bug 11593 Is checked on Responsible Entities (responsible for completion of Workflow 
Activities) and Notify Only Entities (to receive notice only) in Plan DE>workflow 
settings. Now open matter DE>Workflow tab. Add this plan, after start it. 

  Dalia   

Workflow DE Bug 12032 Changing the date in the last Workflow History record is causing the Event 
Date field to be cleared and the item becomes Unscheduled 

  Tom   

Workflow DE Bug 12052 After upgrade there are critical dates items that have STATUS = 1. Critical 
Date item can have only 2 statuses, Not complied with, Complied with (0 and 
2). 

  Darius K   

Workflow DE Bug 12105 Order of Tickler fields on Workflow DE and in listings   Tom   

Workflow DE Bug 12130 In Court Event DE, click on Judge faucet filter - on big database get timeouts Glasser & 
Glasser - 0185 

Gedas 23248 

Workflow DE Bug 12212 Incorrect behavior on the Workflow Filter - Entities tab when choosing entities   Tom   

Workflow DE Bug 13399 Invoke atached to tabs child forms FormClose method   Saulius   

Workflow DE Bug 13576 It is possible to open multiple instances of same entity from Workflow DE 
Entities tab 

  Donatas   

Workflow DE Bug 13708 User creating workflow item loses changes to the Time fields upon selecting 
another tab. When returned to item's main screen, the default time settings had 
been restored over the user's selections.Tab change should save info as in 
other de forms 

  Ken F, 
Mike G 

24673 

Workflow DE Bug 13713 Message in Worklfow DE when creating a Task or Critical Date   Abe   

Workflow DE Update 11117 Restore "Show All Paths" Functionality in Workflow Plans   Tom   

Workflow DE Update 11457 When a Workflow Item on a Plan does not have a branch under it, do not show 
the Delete Branch - Shift Branch Up menu item 

  Tom   

Workflow DE Update 11663 When marking a plan complete, give the option to "Delete branches under 
unselected answers." 

  Tom   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow DE Update 11674 If an unscheduled item is marked completed and the Event/Due date is null, 
populate the Event/Due date with the completion date 

  Tom   

Workflow DE Update 11739 Items under unused answers should be updated along with visible items when 
a plan is marked complete (the action is dependent upon the choice on the 
dialog). 

  Tom   

Workflow DE Update 11747 Update Workflow menu's for listing and Calendar   Tom   

Workflow DE Update 11841 Add system setting to enable ticklers   Tom   

Workflow DE Update 12027 Completed or Cancelled Workflow items can not have their Completed or 
Cancelled date (MRULASS.DATE2) set to NULL 

  Tom   

Workflow DE Update 12034 Allow edit the Status - on field from the DE form   Tom   

Workflow DE Update 12054 After upgrade there are workflow items in listing that have date completed field 
populated but status is not 'Completed' 

  Darius K   

Workflow DE Update 12075 Sub-queries will not always use indexes and also the one in below creates 
table spool 

  Darius K   

Workflow DE Update 12213 Workflow Entities - only Staff are able to be assigned as responsible or Notify. 
See comments 

Glasser & 
Glasser - 0185 

Cynthia K 22954 

Workflow Listing Bug 10154 Right-click (or View) menu filter works incorrectly for Unscheduled items   Donatas   

Workflow Listing Bug 10286 When you execute a workflow activity with actions attached, if, after you 
execute the linked Actions you return to the Plan screen, the Workflow 
Activities do not appear as marked complete, unless you manually Refresh the 
screen. 

  Richard   

Workflow Listing Bug 10300 Status change DE does not appear, when status of item is changed from 
workflow plan by right-clicking. Instead, status is changed to selected with 
current date 

  Donatas   

Workflow Listing Bug 11384 When deleting workflow item with workflow linked activities and hit Yes in the 
question 'Go to Linked Activity?', not Linked Activities tab displayed. 

  Rasa   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow Listing Bug 11519 The Code field is being populated with the name when you use the drop down 
to look-up a value. If you enter a code, it works fine. 

  Tom   

Workflow Listing Bug 11570 Print Preview is not working in Workflow listing.   Dalia   

Workflow Listing Bug 11839 Filter is working incorrect in Workflow listing.   Dalia   

Workflow Listing Bug 11867 Is not synchronized 'Completed' checkbox in Quick filter with workflow filter and 
right click filter. 

  Dalia   

Workflow Listing Bug 11971 Status of workflow item cannot be changed when item is from different than 
current site and site security are enabled 

  Saulius   

Workflow Listing Bug 12039 When you display the global workflow listing, using the default filter, which 
includes uncompleted items, and then switch to the calendar view, none of the 
uncompleted items are displayed. 

  Richard   

Workflow Listing Bug 12288 Can't find a column under global workflow for "activity is related to". Glasser & 
Glasser - 0185 

  23109 

Workflow Listing Bug 12464 After changing the date of a WF item that has been set to repeat, user gets 
information message "You have changed the date of repeating item. The 
repeating items will not reflect this chage." 'Chage' needs to be spelled 
correctly. 

  Mike G   

Workflow Listing Bug 12562 When user do not have Delete Workflow security assigned, he is still able to 
delete item, but only if he does right-click-Delete. CTRL+D or File-Delete 
doesn't delete. 

  Ligita   

Workflow Listing Bug 12570 When Workflow Calendar filter is set to show only Completed activities go to 
Workflow Listing and try to check uncompleted activities in Listing Toolbar. It 
doesn't work; try another time - uncompleted activities checkbox is checked. 

  Ligita   

Workflow Listing Info 13565 Go to workflow listing > click Printer icon > go to Customize tab. Preview 
button is active. Click [>>] button (assign all available fields) > Preview button 
becomes inactive. I need to restart Printing to make this button be active. 

  Arunas   

Workflow Listing Update 10729 Add ability to print workflow item notes when printing the listing. Add 
"Instructions" as being an available field for reports 

  Cynthia K   
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Area Type ID Description/Comments Site Contact Support 
Tickets 

Workflow Listing Update 10927 Modify checking of workflow plan items to only include those items before all 
unanswered questions. 

  Tom; 
Donatas 

  

Workflow Listing Update 11620 Update the workflow listing filter queries for Completed/Uncompleted.   Tom   

Workflow Listing Update 11897 Update Multiselected workflow items Delete action   Tom   

Workflow Listing Update 11900 Update of Workflow Filter Fields   Tom   

Workflow Listing Update 11953 Change layout of Workflow Notes in Workflow report   Ricky   

Workflow Listing Update 13265 Enable New, Open, and Delete buttons on the Select Window when creating a 
workflow item. 

  Tom; 
Ligita 

  

Workflow Listing Update 13350 Cast filter tree item data to Integer where needed, eg.   Arturas   

Workflow Listing 
Query 

Bug 12548 If workflow activity has more than one entity assigned responsible or notify only 
in Workflow Listing appears several identical rows when Workflow Listing 
Query Is Responsible or Is Notify only filter is applied. 

  Ligita   

Workflow 
Settings 

Bug 12618 Access violation in Workflow Settings > Holidays   Mike G   

Workflow 
Settings 

Bug 13019 Access violation error, when trying to type search Date column in Holidays tab 
of Admin Workflow settings 

  Mike G   

Workflow 
Settings 

Bug 13050 Holidays tab: add November and December to type search drop down for Date 
column 

  Mike G   

Worklfow 
Template 

Bug 12454 Activity Templates did not convert the description Shriners - 0209 Ricky   

Worklfow 
Template 

Bug 13276 In System Settings there is one Tickler enabled; in Workflow template Display 
Tickler fields are set to 2, 3, continuously 5 (in exact order) days before Event 
Date; in workflow DE, created with this template, there appears Tickler 5 days 
before. 

  Ligita   
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9. Project Organization 

The project described by this document falls into the standard category of a software deliverable.  The project 
is organized into three levels of responsibility.  The product level, program level, and project level.   

At the project level the schedule and day to day details of the project are managed by a Project Manager.   The 
responsibility of the primary deliverable (the software program) is managed by a Program Manager.   The 
responsibility of the product suite to which the program will be part of, the programs relationship within that 
suite, and external material such as marketing, application support, and client relations are managed by the 
Product Manager.   

The typical workflow of a software deliverable starts with the Product Manager scheduling a kick-off meeting 
with the primary participants in order to discuss requirements, issues, and product strategy.  If the decision is 
to undertake the project then a Subject Matter Expert constructs a Functional Requirement Specification 
(FRS) to communicate the goals of the project be it a new undertaking or an update of an existing program.  
The purpose of the FRS is to ask "what" needs to be included and "why".  It will not describe "how" a 
particular item will be implemented nor can it be viewed in terms of a project.  The product of the (FRS) may 
encompass multiple projects spanning several release cycles and several years. 

The assigned Program Manager then coordinates with the Subject Matter Expert in constructing a Program 
Summary Specification (PSS).  When the inclusions, exclusions, estimated resources,  estimated budget, 
estimated duration, and preliminary plan have been approved the Functional Design Specification (FDS) is 
produced in order to communicate "how" an item will be functionally implemented.   

The Program Manager will coordinate with other resources at his/her disposal in order to clarify the project to 
the Project Manager and Project Lead.  The Technical Analyst and Quality Assurance Manager are two such 
resources that are available to the Program Manager.  A Technical Design Specification (TDS) developed by 
the Technical Analyst may be required of some projects in order to communicate the suggested architecture, 
data model and technical solution to the developers.  The technical review process is important in order to 
keep consistency in the product suite. 

The Program Manager then coordinates with the Project Manager to schedule resources for a project kick-off 
meeting at which time the project plan can be viewed as a reliable estimate.  When the Lead Developer 
completes the coding process the program is turned over to Quality Assurance as many times as necessary to 
root out all A, B, and C bugs which correspond to the level of quality required for an (A)lpha, (B)eta, and 
(C)ertification cycle release. 

At the conclusion of the certification cycle the program can be released to the Product Manager which will 
oversee training and distribution. 

 

10. Roles / Responsibility 
 

Position / Project Role Participant / Person Project Responsibility 

Product Manager Ricky Huszagh 
rickyhuszagh@reallegal.com 

• Review and comment on project 
deliverables. 

• Monitor project progress.  

Subject Matter Expert Not Applicable • Functional Requirement Specification. 
• Review and comment on project 

deliverables. 
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Position / Project Role Participant / Person Project Responsibility 

Program Manager Tom Foley 
tfoley@reallegal.com 

• Review and comment on all project 
deliverables. 

• Project Summary Specification. 
• Functional Design Specification. 

Project Manager Tom Foley 
tfoley@reallegal.com 

• Review and comment on  project 
deliverables. 

• Project Plan 

Graphic Design Lead Tom Foley 
tfoley@reallegal.com 

• Functional Design Mockups 

Quality Assurance Manager Ken Fusco 
kfusco@reallegal.com 

• Test Plan 

Technical Analyst Saulius Kundrotas 
saulius@pmt.lt 
Darius Kirna 
darius_k@pmt.lt 

• Review and comment on  project 
deliverables. 

• Technical Design Specification 

Technical Writer Tom Foley (Release Notes and Install) 
tfoley@reallegal.com 
Cynthia Hobday 
chobday@reallegal.com 

• User Manual, Install Guide, Release 
Notes 

Lead Developer Saulius Kundrotas 
saulius@pmt.lt 

• Review and comment on  project 
deliverables. 

• Turnover to Quality Assurance 

Lead Quality Assuror Donatas Barakauskas 
donatas@pmt.lt 

• Review and comment on  project 
deliverables. 

 

11. Scope Management 

The functional scope of the project is finalized when the FDS is certified.  A functional feature that is not 
specified before the certification of the FDS will not be included unless the Product Manager certifies the 
inclusion and the Project Plan is updated.  This scope creep is allowable if a situation arises that requires the 
inclusion in order to meet customer demand or satisfy a strategic purpose.   

If a functional item is generated from one of the following statements without meeting any higher purpose 
then it does not qualify to be included: "wouldn't it be nice if we added this", "we did that so why not this 
too..." or "it does that but it would be better if it did this instead".   

At each stage of development reasons for scope creep work their way into a program primarily because 
foreseeing all options is a difficult if not impossible task.  However, in order to meet deliverables, stay on 
budget, and within the given timeline some functional requests must be deferred or discarded permanently. 

A different form of scope creep is technical scope creep.  Technical decisions and architecture can often 
impact the duration of a project and in some cases can be viewed as providing functionality to the program.  
These decisions often cannot be made at the time that the functional feature set is locked down and therefore 
are permissible and expected to some extent. 
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12. Risk Management 

The risk to this project has been quantified based on the estimated project duration of [xx] days described 
later.  The reader may use the last column of the following table in order to rank each risk by its total impact 
on the project.  The project should be planned around the top 20% of the risks listed in the following table.  
Using this rule the most critical decision for planning this project is [....] 

 

ID Risk Effect Mitigation Probability Impact Exposure 

1 Number of PCRs to be 
inlcuded in the release 
increases. 

Coding and testing time 
will be increased. 

 75% Unknown Unknown 

       

       
 

13. Issue Tracking Management 

Any issue that arises during the course of the project must be routed to the Program Manager along with 
possible resolutions.   The Program Manager will coordinate with the available resources in order to resolve 
the issue and will notify the Project Manager of any slippage in the schedule that will result.  If the issue 
cannot be resolved then an alternative solution will be presented to the Product Manager if that solution 
effects the functionality that was certified at the onset of the project. 

 

14. Quality Review Management 

Certified functional items will be entered into the internal tracking system at the onset of development.  Any 
item originating from scope creep will be entered into the internal tracking system at the moment the item is 
certified.  Quality Assurance will enter items during the test cycle phase.  Any item that hinders the 
functionality of the program without a possible workaround is assigned (A) priority and must be resolved 
before the product can enter beta phase.  An item that hinders functionality of the program but is able to be 
worked around is assigned  (B) priority and must be resolved before the product can enter the certification 
phase.  An item that does not hinder the functionality of the product is assigned (C) priority and must either 
be resolved before the product is certified or deferred to a later release. 

 

15. Monitoring Mechanisms 

The Team Leader or Lead Developer if the Team Leader is absent is responsible for communicating all issues 
to either the Project Manager or Program Manager depending on the nature of the issue and for delivering a 
status report at the conclusion of each week.   The Project Manager is responsible for communicating 
slippages to the Program Manager at least twice a week.  The Program Manager is responsible for 
collaborating with all available resources and giving a status report to the Product Manager once each week.   

 

Mechanism From To Frequency 

Status Report Team Leader / Lead Developer Program Manager Every Friday 

Predicted Issue Report Team Leader / Lead Developer Program Manager Conclusion of Alpha 
Development 

Project Report Project Manager  All Every Tuesday  

Status Report Program Manager Product Manager and Product 
Manager Internal 

Every Wednesday 
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Mechanism From To Frequency 

Phase Review Program Manager Subject Matter Expert Conclusion of Alpha 
Development 

Turnover Notice Team Leader / Lead Developer All Conclusion of Cycle 
Development   

Published Notice Project Manager Program Manager QA Acceptance of a Turnover 
 

16. Deliverables 

The project is divided into multiple stages and multiple phases.  The term phase is used to describe a portion 
of the project cycle as well as the division of functionality among multiple releases.  In the following table the 
term phase represents a portion of the project and not a release.  This plan covers only the tasks required to 
complete this release. 

 

Phase Stage Responsibility Deliverable(s) 

Product Manager • Project Proposal / Meeting 
• Needs Requirement 

Subject Matter Expert • Functional Requirement 
Specification 

Program Manager • Project Summary 
Specification 

Technical Analyst • Technical Impact 

Planning Phase Program Initialization 

Practice Manager Program 
Manager 

• Impact Assessment 

Program Manager • Functional Design 
Specification 

Functional Design 

Quality Assurance Manager • Test Environment Design 
& Plan 

Analysis Phase 

Technical Design Technical Analyst • Technical Design 
Specification 

• Data Model 

Project Initialization Project Manager • Resource Allocation  
• Development Plan 

Coding Lead Developer • Source code & compiled 
code 

• Predicted Issue Report 

Testing Quality Assurance • Issue Report 

Development Phase 

Conclusion Program Manager • Project Post-Mortem 
 

17. Project Plan 

The following links to the external Microsoft Project 2000 Project Plan. 

http://pm.reallegal.com/reallegal/download/rd/schedules/current_development_scheduled.html 
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18. High-Level Project Plan 

The following table outlines the high-level milestones developed for this release of Project Summary 
Specification v2.0 (phase one).  The exact dates will not be known until the development schedule is 
produced. 

 

ID Phase / Stage Duration Days In Planned 
Finish 

Slippage Actual 
Finish 

1. Project Preparation 205 N/A 04/03/2002   

2. Alpha1 Coding and Testing (Original scope) 34 N/A 08/16/2002 N/A 08/16/2002 

3. Alpha2 Coding and Testing (Dupe PCRs) 110 N/A 05/02/2003   

4. Alpha3 Coding and Testing (SP3-related work) 25 N/A 05/09/2003   

5. Beta Testing and Bug Fixing 25 N/A 06/13/2003   

6. Acceptance 7 N/A 06/20/2003   

7. Availability Announcement 1 day N/A 06/23/2003   

8. Orientation 1 day N/A 06/24/2003   
 


